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A. What is CellDesigner™

CellDesigner is a process diagram editor for drawing gene-regulatory and biochemical networks.
Networks are drawn based on the process diagram, with graphical notation system proposed by
Kitano, and are stored using the Systems Biology Markup Language (SBML), a standard for
representing models of biochemical and gene-regulatory networks. Networks are able to link with
simulation and other analysis packages through Systems Biology Workbench (SBW).

CellDesigner = SBML + SBGN + Simulation + Databases Connections
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[

. CellDesigner Major Features

Easy-to-understand graphical notation (SBGN compatible)
SBML-compliant

Built-in simulator (SBML ODE Solver, Copasi)

Integration with analysis tools and other simulators via SBW 2.x
Database connections

Intuitive user interface

Extensive description of Compartments, Species, Reactions, and Proteins
Export of images in PNG, SVG, JPG, and PDF formats

Support of Block Diagram (*Proto-type)

Plug-in development framework

1.1 New Features --- Version 4.4
CellDesigner 4.4.

- See also: http://celldesigner.org for details.

Major new features and changes in CellDesigner 4.4 are as follows:
® ChEBI support on Database menu
® Plugin APl: SBGN-ML export, run Simulation

® Solver selection assistance
CellDesigner now checks a model before running a simulation.
Currently CellDesigner disables SOSIlib when:
1. a model contains "delay" csymbol (which will be DDE)
2. a model contains <functionDefinition>
3. a model contains <algebraicRule>
and disables COPASI when:
1. a model contains "Delay" csymbol.
The reason is shown in pop-up message of each radio button.

® |Installer update
® Linux 32bit and 64bit support
® Mac OSX (Marvericks) support

® SABIO-RK API connection
- See also: Chapter 9.2.3 “To import the reaction information from SABIO-RK database”

® Libraries update
® SBGN-ML library

- See also: Chapter 13.4 “Export to SBGN-ML file format
® libSedML library

- See also: "To save simulation conditions into files” and “9 Parameter Polymorphism” sections
in “Running CellDesigner Simulation with Control Panel” quick tutorial.

® SimulationCore library
® DBGET link update

® Sample files update
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2. CellDesigner and SBML

SBML (Systems Biology Markup
Language) is a machine readable
format (XML) for representing
computational models in systems
biology. Over 100 software
packages now support SBML. Its
focus is to describe the systems of
biochemical reactions. Models can
also include compartments, events,
rules and constraints.

Compartment

CellDesigner can read/write in
SBML format with rich enhanced
functions stored as SBML annotations.

Species

Reaction

Reactants: R

“Kinetic law™:
v VR T M, parameters )

Reactant Product

Blochemical reaction

Products: P

_—Modifiers: M ,r"‘i K1+ X0 /a I

s
At ooy
AN 0" X"
<spocio) neve “Sits
<) UM e
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«LACE Laoctinds
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Sh e Bl ST RO
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~RBOCUIT
A0 e .

SBML representation

o

For details of SBML, please refer to http:/sbml.org website.

SBML format

<?xml version="1.0" encoding="UTF-8"7>
<sbml xm1ns=”http://www.sbm?.
<model name="ATitle”>
<1listofcompartments>
<1listofspecies>
</1istofspecies>
</T1istofCompartments>
</model>
</sbml>

org/sbml/levell” Tevel="2" version="4">
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3. CellDesigner and Graphical Notation

CellDesigner supports graphical notation and listing of the symbols based on proposal by Kitano
and adopting the most of SBGN (=Systeme Biology Graphical Notation) Process Diagram Level 1.1
notations..

SBGN (Systems Biology Graphical Notation) (http://sbgn.org) is a graphical notation for
representing biological interactions, such as protein-protein interactions and gene regulatory
networks. Current discussions on SBGN focus on three graphical notations: process diagram, entity
relationship diagram and activity flow. CellDesigner adopts the process diagram as its graphical
notation.

[¥ — 1
MKK_P L oot
=5 = { Ol
MKK — Q. Q) ey :_‘(.)»_;%) 0
NKK_PP —
) V\\\»‘r
MAPK Y | o
AP :s T/ Ly S e — R ’
MAPK_FF T

\\M(KK_P wr. Bl 'E( wp }}:c}] e wAPK J

Pure SBML without notation SBML with notation

CellDesigner Ver. 4.2 introduced new notation called “Reduced Notation”. The following notations,
which can be connected with Species, have been added:

® Positive Influence

® Negative Influence

® Reduced Stimulation

® Reduced Modulation

® Reduced Trigger

® Unknown Positive Influence

® Unknown Negative Influence

® Unknown Reduced Stimulation

® Unknown Reduced Modulation = ]
® Unknown Reduced Trigger < 5 —
\
N N
These notations can be connected with other Reduced " =)
Notations.

Boolean logic gate can be connected with these notations.

T =)
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Reaction, Add reactant, and Add product are not allowed to connect with Reduced Notation.

-> See also: “Appendix 1.1.9 Reduced Notation”

Species

[[roen |

residue binding
Thrl4 region

{Hypothetical 1
I )

Receptor

Truncate (Truncateq|! @
e | proten i hosphoryiated - palmytoyiated

@
o Acetylated Prenylated

®
Phophorylated
®
(@)
Methylated

Qg (1

Unknown

E>—{+)

Plasma Membrane

Species

Complex

Mofification Site

Coffiplex(t,u,CaZft)

‘ Mo e
Gene B

Complex(t,u,Ca2+)

Complex

Compartment

Compartment Square

Compartment

Reactions

Standard Notation (Process Description Diagram)

B0

state transition

inhibition

degradation

homodimer formation

unkonwn catalysis

bidirectional reaction

unknown inhibition @

stimulation
add reactant 5
add product modulation m
heterodimer
association trigger

Standard Notation (PD)

Reactions

Boolean Logic Gate

Boﬂ ﬂoﬂ

And or Not
Boolean Logic Gate

Glyphs used in the graphical notation of CellDesigner

- @ @ ~—®

)
= ©

<

=0

Reduced Notation

negative influence

positive influence

reduced modulation

reduced stimulation

reduced trigger

unknown negative influence

unknown positive influence

unknown reduced stimulation

unknown reduced modulation

unknown reduced trigger

Reduced Notation

Style Variation Layer

paint Layer Comment
gradation ’,
.
3
o> |

Style Layer Annotation

- See also: “Appendix 1 Symbols and Expressions” for details on CellDesigner graphical

notation

10



CellDesigner™ Startup Guide

B. Startup Guide

1. Installation and Startup

1.1 Operating Environment

111 OS

® Windows (Vista or later) 32bit only
® Mac OS X (10.6 or later) 32bit, 64bit
® Linux with X Window System (Fedora Core 4 or later is recommended)

On Linux platform, due to the version of native libraries, Fedora Core 4 or later is recommended;
some problems will arise if you use other than these.

For 64bit Windows Users, CellDesigner supports 32bit only. Please install CellDesigner onto 32bit
mode.

1.1.2 Java

The current version of CellDesigner requires JRE (Java Runtime Environment).

The installer for Windows and u includes JRE (Java Runtime Environment 1.6), so you do not have
to install Java before your installation.

On Mac OS X 10.6 or later, Java 1.6.0 or later is required.

JRE is not included in Mac OS X Mavericks, so CellDesigner will ask you to install JRE (or JDK) on
your system. Please follow the instruction from CellDesigner.

1.2 Install SBW and SBW Modules

If you are interested in time evolving simulation and analysis on biochemical networks, we
recommend you to install the Systems Biology Workbench (SBW) and SBW-powered software before
you install CellDesigner.

Please check http://sys-bio.org/ and download the software from Software Downloads section.

To install SBW and SBW-powered software, follow their installation instructions.

If you would like to use CellDesigner alone right now, you can postpone this step until you need
simulation and/or analysis.

- Note: For details on SBW information, go to
http://sys-bio.org/research/sbwintro.htm

1.3 Install CellDesigner

The current release is distributed in archived installer package for each operating system.

Windows: cellpesigner-44-windows-installer.exe
Mac OS X: cellpesigner-4.4-osx-installer.dmg
Linux: CellDesigner-4.4-Tinux-installer.bin

While J2RE is required for CellDesigner to run, the installers include it. Therefore, you do not need
to download or install J2RE.

1.3.1 Windows
11
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1. Double click cellpesigner-44-windows-installer.exe.
The installer window should open, and follow the message therein.
2. Follow the instruction of the installer.

1.3.2 Mac OS X

1. Double click cellpesigner-4.4-osx-installer.dmg.
The .dmg file should automatically be mounted and a Finder window should open in which
CellDesigner-4.4-osx-installer exists.

2. Then double click it

3. The installer window should open, and follow the message therein.
1.3.3 Linux

—

Open a shell and, cd to the directory where you downloaded the installer.
2. At the prompt, type,

% chmod u+x CellDesigner-4.4-1inux-installer.run

% ./CellDbesigner-4.4-1inux-installer.run

The installer window should open, and follow the message therein.

- Note: In case you have installed SBW 2.7.6 or later, and you encounter an error while installing CellDesigner,
there might be a possibility that the C++ Broker is up which prevents CellDesigner to start. Please try to kill the
broker using the Task Manager, or restart your system before you resume the CellDesigner installation.

1.4 Installed File Images

After installation is finished, you would see the following directories/files in the installation
directory (/cellDesigner4.4 by default).

+00README . txt
I

+CellDesignerd.4.exe executable application module (* Windows only)
+CellDesigner4.4.sh executable application module (* Linux only)
+CellDesigner4.4 executable application module (* Mac OS X only)
|
+/documents
| +ControlPanelédd.pdf quick tutorial for control panel
+PluginTutorial43.pdf quick tutorial for plug in
+StartupGuide44.pdf this document
+/plugin
+index.html Plug-in API document

/exec
+autolayout yobf.jar

+celldesigner.jar library for CellDesigner application
+yObf.jar

|

|

|

|

|

_|..

|

|

|

|

+/jre (1.6) *(Windows, Linux only)
|

+/1ib

| +tant-schematron.jar

| +avalon-framework-4.1.4.jar
| +axis.jar

| +batik.jar

| +browserlauncher.jar

| +collections-generic-4.01.jar
| +Commons-discovery-0.2.jar
| +commons-io-1.4.jar

| +commons-logging-1.0.4.jar
| +commons-math-2.2.Jjar

| +concurrent.jar

12
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+copasi.jar

+copasi gui.jar
+customizer.jar
+freehep-export-2.0.3.jar
+freehep-graphics2d-2.0.jar
+freehep-graphicsio-2.0.jar
+freehep-graphicsio-ps-2.0.jar
+freehep-io-2.0.1.jar
+freehep-swing-2.0.2.jar
+freehep-util-2.0.1.jar
+icu4j 3 4,jar

+iri.Jjar

+itext-1.4.6.jar

+jai _codec.jar

+jai core.jar
+Jakarta-oro.jar
+jaxen-1.1.1.jar
+jaxrpc.jar
+jcommon-1.0.0-pre2.jar
+jdom-contrib. jar

+jdom. jar

+jena.jar
+jersey-client-1.2.jar
+jersey-core-1.2.jar
+jeuclid-2.0.jar
+jfreechart-1.0.0-pre2.jar
+jlibsedml.jar
+jmathml.jar

+Jmf.jar
+jsbml-1.0-incl-1ibs.jar
+jsr3ll-api-1.0.jar
+junit-4.8.jar
+log4j-1.2.12.jar
+mediaplayer.jar
+miglayout-4.0-swing.jar
+mlibwrapper jai.jar
+MRJAdapter.jar
+multiplayer.jar
+openide-lookup-1.9-patched-1.0.jar
t+org.sbgn.jar
+pantherConverter.jar
+p0i1i-3.0-rc4-20070503.jar
+quaqua-filechooser-only.jar
+saaj.jar

+sabiows.jar

+SBGN.xsd

+sbgn _pd.sch

+sbmlj.jar

+SBWCore. jar
+SimulationCorelibrary v1.4 slim.jar
+50S1lib.jar

+UlmGraph.jar
+wsdl4j-1.5.1.jar
+xercesImpl.jar
+xml-apis.jar
+xom-1.2.1.jar

+CellDesignerd.4.ico *(Windows only)
+bzip2.dl1l *(Windows only)
+CopasiJava.dll *(Windows only)

13
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+libexpat.dll
+1libsbml.dll

*(Windows only)
*(Windows only)

+sbmldj.dll *(Windows only)
+S0SlibJava.dll *(Windows only)
+z1ib.d1ll *(Windows only)

I
+1libbz2.s0.1

+1libCopasijava.so

*(Linux only)
*(Linux only)
*(Linux only)
*(Linux only)
*(Linux only)
*(Linux only)
*(Linux only)

+libexpat.so.1l
+1libsbml.so
+1libsbmlj.so
+1ibSOSlibJava.so
+libz.so.1

I
+1ibbz2.1.0.dylib
+1libCopasidava.jnilib
+libexpat.l.dylib
+libquaqua64.jnilib
+1libsbml.dylib
+libsbmlj.jnilib
+1ibS0OSlibJava.jnilib
+1ibz.1.dylb
I
+/licenses
| +/celldesigner
| +license.txt
| +/libraries
| +axis.LICENSE. txt
| +batik .LICENSE. txt
| +batik.NOTICE.txt
| +FreeHEP.LGPL. txt
| +FreeHEP.LICENSE. txt
| +itext-MPL.LICENSE. txt
| +jai.LICENSE. txt
| +jfreechart.LICENSE. txt
| +1ibsbml.LICENSE. txt
| +mrjadapter.LICENSE. txt
| +quaqua.LICENSE.html
| +xerces.LICENSE. txt
| +xercesImpl.LICENSE. txt
| t+xercesImpl .NOTICE. txt
| +xml-apis.LICENSE-SAX.html
| +xml-apis.LICENSE.DOM-documentation.html
| +xml-apis.LICENSE.DOM-software.html
| +xml-apis.LICENSE. txt
| +xml-apis.NOTICE.txt

| +yfiles-3rdPartylLicenses.html

|

|

|
+
|
|
|
|
|
+

*(Mac OS X only)
*(Mac OS X only)
*(Mac OS X only)
*(Mac OS X only)
*(Mac OS X only)
*(Mac OS X only)
*(Mac OS X only)
*(Mac OS X only)

+yfiles-GenerallicenseTerms.html
+yfiles-GeneralTermsandConditions.html

/Microsoft.VC80.CRT *(Windows only)
+Microsoft.VC80.CRT.manifest
+msvcm80.d11
+msvecp80.dl1
+msvcr80.dll

/patches *(Mac OS X only)
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| +fixJavaApplicationStub.sh

+/plugin compiled plugin jar files are added in this directory
| +MappingArrayMass plugin.jar

+/samples
| +components44.xml sample for various components
+databased4.xml sample for database connections
+M-Phase.xml sample for model editing
+M-Phase2.xml sample for model editing
+Macros.xml sample for macros
+MAPK . xml sample for simulation provided by SBML ODE Solver
+MAPK42.xml sample for simulation provided by SBML ODE Solver

+SBGNRefCard.xml

+siml.xml

+sim2.xml

+unitOfInformation.xml sample for unit of information

+/nbt sample files used in Nature Biotech paper by Kitano

+/plugin sample source and jar files for plugin
+/sbml samples from SBML specifications

mmlctop2 0.xsl

|
|
|
|
|
|
|
|
|
|
|
| +/notation sample files for notation
|
|
|
+
|

+uninstall.exe *(Windows only)
+uninstall *(Linux only)
+Uninstaller *(Mac OS X only)
+Uninstall CellDesigner4.4 *(Windows, Linux only)
+uninstall.dat *(Windows, Linux only)

1.5 Startup CellDesigner

151

152

153

—

Windows

Double click the shortcut icon for CellDesigner4.4 3 in your desktop.
Or double click cel1Designer4.4.exe in the directory where you chose to install
(c:/program Files/cCellDesigner4.4 by default).

Mac OS X

Double click the CellDesigner4.4 icon &3 in the folder you chose to install
(/AppTlication/cellDesigner4.4 by default).

Linux

On a shell, type ./runcellbesigner4.4 in your home directory.
Or type ./runCellDesigner4.4 after changing to the directory where you chose to install
(cel1Designer4.4 in your home directory by default).
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1.6 CellDesigner User Interface and Navigation

CellDesigner consists of Menu, Toolbar, and the five areas as shown below

’f}(}(:ll[)omzm:r @@@
fila Eda Component View [Datsbase Layout Phagin Preference Help Menu
HeEdEd 2 CcBBEHRE 5 BNV - ZFE AEBES
EEEEE- =P a-U— -
- Toolbars
o = Yoo = P g | 3 i D g e O 3 | —p S =
Q0 rn Ld=| | = C PR NN Dok 000 T A0 A N0 19D 0 NI M
L Model :
® Compartments
® Species
® Reactions
Draw Area
Tree Area

( —_)\ N 7\
-}c’:ﬂg (y’u Protens | Genes ‘| :ﬁf MIRIAM
class ) name
Layer Area
List Area Notes Area
S L
Draw Area: To draw a model
List Area: To display and edit the list of the components, functions of a model
Notes Area: To display and edit the notes of the component
Tree Area: To display all the list of the components in the tree structure.
Layer Area To display all the layers of the model.

1.6.1 To change the size of each Area

—

The size of the areas can be changed by dragging the borderlines.
2. To maximize the area, click the triangle icons on the borders.
(See the orange circles in the above screen.)

1.6.2 To change the position of List and Notes Areas

1. To switch the display position of the List and Notes Areas,
select View - List menu, then select Right or Down.

1.6.3 To customize Toolbar

—

Each group of the icons can be detached from the Toolbar.

2. It can also be moved to the side (left or right) or the bottom of the main window by dragging
the handle.

1.6.4 To show / hide Toolbar

1. Select View — Change Toolbar Visible menu, then select the toolbar component you want to
show/hide.
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2. Quick Tutorial of Model Building

This section is for beginners, and describes how to edit a model with CellDesigner in brief.

A sample file “M-Phase.xm1” is used in this tutorial since this model contains most of the essential
CellDesigner's expressions of biochemical networks.

2.1 Open a Sample Model

1. Select File - Open in the Menu to open M-Phase.xm1 in the “samples” directory.
2. A graphical network model is displayed on the Draw Area.

I (0 Gt (e [sldme (e st fos e (58 Sewew 196
T . e c . AR TS
- o Owly —swmisamas | 1. LML OD OO
e T ot T LR LYY L

3. In the Menu, select File — Save as... to open the Save dialog.
4. In the File name text box, enter a new name, e.g. “M-Phase_Test.xm1”.
5. Click Save.
6. Drag the borders (Ieft or right) of the Draw Area to change the area size.
Species || Pro
2.2 Zoom

1. You can change the zoom view of the model by clicking the following icons.

VR T = S R S

2.3 Select a Component

A component is a general term for a Species (including a Complex), a Reaction, or a Compartment.
Thus, any shape you see on the Draw Area ---a rectangle, an oval, or a line segment--- is a
component.

231 To select a Component
1. Confirm that Select Mode icon is highlighted. If not, click the arrow icon.

R

2. Select a component in the Draw Area. For instance, select the green square-shaped
component labeled “CAK” which you will find in the upper left corner of the Draw Area.
This shape indicates that the component is a Protein.

17
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3. Observe that the green square, a Protein, and also the linked line, called a Reaction, are
highlighted.

2.4 Move / Delete a Component

1. Select a Species (e.g. a Protein) and drag it to see the linked Reactions follow as the Species
moves.

2. Delete the Species by the Delete key, and see the linked Reactions are deleted as well.

3. To undo the deletion, select Edit — Undo in the Menu bar.

2.5Undo / Redo

You can “undo" the previous actions by Ctr1-z, and also “redo” after the undo by ctr1-y before
saving the model.

- For Mac OS X, use Command key instead of Ctr1 key.
25.1 To undo or redo the previous action

1. Undo by Ctrl-Z.
2. Redo by Ctrl-Y.

2.6 Change the Size of a component

1. When you select a Species or a Reaction, you will find small squares on it. These are the
handles to change their size or to bend the line of the Reaction.
2. Select one of the small squares and drag it.

2.7 Compartment
The shape with a thick (and yellow by default) border line is called a Compartment.

A Compartment is a container for other components and can also hold other Compartments in it. A
Compartment represents a generic bounded container, such as a cell or an intracellular
compartment. The change in its size and shape only affects its appearance on canvas, and has no
effect on semantics of biochemical and gene networks.

2.7.1 To put components in a Compartment

1. To select a Compartment, click on its border line.

-

2. See the edge of the border line is turned into magenta and the Species inside are shadowed.
A Compartment can hold Species and other Compartments inside.
Drag the Compartment, and confirm that the Species inside follow it.

-

2.7.2  To change the shape of a Compartment

Select a Compartment.

In the Menu, select Component — Change to OVAL.
Observe the shape has changed to an oval.

Select the Compartment again.

Ll
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5. In the Menu, select Component — Change to SQUARE and observe the shape has changed
to a square.

2.7.3  To change the position of the Compartment name

1. Find the Compartment name which is initially located at the bottom of the Compartment.

- Note: In the M-Phase_Test.xml1 sample model, you will find “cell” as the Compartment name.

2. Select the Compartment name, drag and drop it wherever you want.

2.8 Species and Reactions

A Species represents, for example, a ¥
protein or some other molecule in a Graphic Notation Space

biochemical network, or a gene in a gene
regulatory network. Species

A Reaction represents a state transition of
the connected Species such as a
biochemical reaction, an interaction
between proteins, and a regulatory Process Node
relation between genes.

Reaction

The biochemical and genetic meanings of

Species and Reactions are distinguished y Compartment ¢
by their symbols. The list of all symbols
that can be drawn using CellDesigner and Symbolic Process Expression of the CellDesigner

their meanings are described in
“Appendix 1: Symbols and Expressions”.

2.8.1 To change the symbol of a Species

If you double click a Species or a Reaction, a dialog box will appear to alter its properties.

1. Double click a Species, for example, “CAK”, then the Change identity of the species dialog
box will be displayed.
I Churen ity of

[CRob ] fot | | coewt |

2. Change the value in the class drop-down menu. You can switch from Protein to Gene, RNA,
Ion, etc., and vice versa.

If necessary, enter a name the name text box.

4. Click Apply button and see the shape has been changed.

o
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2.8.2 To change the symbols of Reactions

1. Double click a Reaction.

STATE SRAKSITON
Reversble (0w TRANGITION OMETTED
UNCNO W TRANGITION
TRANSCIGPTION
THANGLATION
THANSPORT

2. Change values in the dialog box, and see what have been changed after clicking OK button.

2.9 Activate a Species

2.9.1 To activate a Species

1. Select a Species.
2. Type “a” on keyboard.

Or, select Component — Set Active in the Menu.
3. See the Species is wrapped by a dashed line.

- Note: The dashed line has a somewhat ambiguous meaning, indicating only that the Species is “active”
without referring to its targets.

- See also: “Appendix 1.1 Basic Symbols”
2.10 Close a Model

2.10.1 To close afile without saving any changes.
1. Select File — Close.

2.11 Create a New Model

2.11.1 To create a New Model

1. Select File - New menu or press Ctrl-N.
The New Document dialog will display.

2. Specify Name, Width, and Height of a new model.
3. Click OK.
- Note: For Mac OS X, use Command key instead of Ctrl key.

- Note: The Name you specify here will be not only the file name but the model id in the xml file when you select
File — Save in the Menu. Therefore, the Name needs to conform to SBML convention.
e.g. If you specify “sample” here, the file name will be “sampTe.xm1”, in which <mode1 id="sample"> is
written.
However, if you select File — Save As ==+ in the Menu, you can give a file name different from the model id in the
xml file.
e.g. If you save as “sam ple”, the file name will be “sam ple.xm1” but the model id is still <mode
id="sample">. See the file name has a space in it but the model id does not.

- Note: Naming Convention
The model id only accepts the Type Sid defined in SBML specification as follows:
letter ::="a’..’z’/A'..’Z
digit ::='0"..’9
idChar ::= letter | digit | "’
SId ::= (letter | *’ ) idChar*

- See also: Systems Biology Markup Language (SBML) Level 2: Structures and Facilities for
Model Definitions
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2.12 Create a New Compartment, Species and Reactions

If you want to create a new Species, Reaction, or Compartment, use icons on the tool bar.

- See also: “Appendix 1 Symbols and Expressions”
2.12.1 To create a new Compartment

1. Select an icon from the Compartment tool bar (as shown below).

B ra Y2 =| | =«
2. Place your cursor anywhere on the Draw Area to make a Compartment of your favorite
size.

3. In the Property of compartment dialog, specify its Name and Size.

- Note: The size may be a volume (if the compartment is a three-dimensional one), or it may be an area (if the
compartment is two-dimensional), or a length (if the compartment is one-dimensional).

- See also: Systems Biology Markup Language (SBML) Level 2: Structures and Facilities for
Model Definitions, “4.7 Compartments”

2.12.2 To create a new Species

1. Click and select an icon from the Species tool bar (as shown below).
2. Click anywhere on the Draw Area where you want to place the new Species.
OMMagoos o 0 SO e (D) ¢

2.12.3 To create a new Reaction

1. Click on an icon from the Reaction tool bar (as shown below).
each icon, see the following sections.
See also: “Appendix 1.1.6 Reaction (State Transitions and others)”

See also: “Appendix 1.1.7 Reaction (Modifications)”
See also: “Appendix 1.1.8 Reaction (Logical Operations)”

vy

2.12.4 To create a new Reaction - State Transition <One to One type>

1. On the Reaction Toolbar, click one of the following icons. (from left to right)
— ek - -
-State Transition
-Known Transition Omitted
-Unknown Transition
-Transcription
-Translation
-Transport
2. Click a Species as the start-point.
3. Click another Species as the end-point, and see a Reaction line has been drawn.

2.12.5 To create a new Reaction - State Transition <Two to One type>
1. On the Reaction Toolbar,

B st tE e Lo 6 LGN

click the following icon.

o

-Heterodimer Association
Click a Species and then another for start-points.
3. Click a Species for an end-point, and see a merged Reaction line is drawn.

N
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2.12.6 To create a new Reaction - State Transition < One to Two type >

1. On Reaction tool bar,

e oL A

click one of the following icons.
<
-Dissociation
“Truncation
2. Click a Species for a start-point.
3. Click a Species and then another for end-points, and see a forked Reaction line is drawn.

2.12.7 To create a new Reaction - Add Reactant

1. On Reaction tool bar,

B st tE e Lo 6 LGN

click the Add Reactant icon.
A

Click a Species to start at.

2.
3. Place the cursor on a Reaction and find a blue point.
4. Click on it, and see a Reaction line is drawn.
2.12.8 To create a new Reaction - Add Product
1. On Reaction tool bar,
R = om ol A
click the Add Product icon.
2. Place the cursor on a Reaction and find a blue point.
3. Click on it.
v D Cor D
L\ L

4. Click a Species to end at, and see a Reaction line is drawn. *
2.12.9 To create a new Reaction - Modification

1. On the Reaction Toolbar, click one of the following icons,
S N A A
-Catalysis
-Unknown Catalysis
-Inhibition
-Unknown Inhibition
-Physical Stimulation
-Modulation
-Trigger
2. Click a Species for a start-point.
3. Click a square (“process node”) on a Reaction for an end-point, and see a Reaction line is
drawn.
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ss
Reaction
Species Modification
7 ﬂ : > 3 D g >E
Reaction Process Node
tate Transition

CellDesigner Reaction and Process Nodes

- Note: You can connect Modification arc to Species “Phenotype” directly.

2.12.10

To create a Homodimer/ degradation / tag

There are some icons with actions not mentioned above. Try the followings after selecting the icons
and see what happens.

1.

2.12.11

o

2.12.12

3.
4.

To create a Homodimer Formation, click the Homodimer Formation icon e , then click a
target Species.

To create a Degradation, click the Degradation icon Y , then click a target Species..
To create a Tag, click the Auto Create Tag icon D, then click a target Species.

To create a Boolean logic gates

Draw two Species and connect them with a Reaction (State Transition).

:

Or equivalently, on the Toolbar, select the State Transition macro icon 5 |_E
and then click anywhere on the Draw Area.

Draw two more Species.

On the tool bar, click one of the icons below.

ClO0 Select the two Species painted last.

Then click a square (“process node”) on the Reaction (State
Transition), and see a Reaction line is drawn.

O ke 8

=
W_ﬂ-’"
EREEEn

Reluced homsoon

See also: “Appendix 1.1.8 Reaction (Logical Operations)”

To create a new Reaction — Reduced Notation (New to Ver.4.2)

The Reduced Notation Toolbar is hidden as default.
To show the toolbar, select View — Change Toolbar
Visible menu to set it visible.

On the Reduced Notation Toolbar, click one of the
following icons,

e e TS PTG T

Positive Influence
Negative Influence S N - g
Reduced Stimulation

Reduced Modulation

Reduced Trigger

Unknown Positive Influence
Unknown Negative Influence
Unknown Reduced Stimulation
Unknown Reduced Modulation
Unknown Reduced Trigger oo soiien 185}
Click a Species for a start-point. by it vt G-~ 5 0
Click another Species. e mescaa w7} - - oo
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2.12.13 To create a new Reaction — Reaction on Reaction Reduced Notation

These notations can be connected with other Reduced |
Notations. — S——
1. On the Reduced Notation Toolbar, click one of < ;
the following 1
i ° iw—lcrililf:(;ns’ | R e T v v
: - I g :L, = ﬁ
Positive Influence ‘_

Negative Influence
Reduced Stimulation
Reduced Modulation
Reduced Trigger
Unknown Positive Influence
Unknown Negative Influence
Unknown Reduced Stimulation
Unknown Reduced Modulation
Unknown Reduced Trigger
2. Click a Species for a start-point.
3. When you float over the center of another Reduced Notation, a square (“process node”) pops
up.
4. Click the point where it pops up.

2.12.14 To use Boolean Logic gate with Reduced Notation Reaction

Boolean logic gate can be connected with these notations.

- Note: A Reduced Notation cannot be connected to a standard Reaction, such as a State Transition. The
reverse is also true, a standard Reaction cannot be connected to a Reduced Notation.

2.13 Create a Complex

2.13.1
1. Click the Complex icon on the Toolbar.

g 0 e R e W S c:::@czn

2. Move the cursor onto the Draw Area and click the left mouse button to place a Complex.

3. In the Name of the species dialog box, enter a name of your choice. The name can be a
simple name as well as a long name which includes the names of the species contained in
the Complex, e.g. “Complex(ProteinA, ProteinB, ProteinC)”.

4. 'To place Species in the Complex, just drag and drop them into the Complex.

To create a Complex

- 3 r ™
| Protein B ] ‘ Protein B | Protein B |

Protein C

!

Complex X

L9 -

\

Frotein C

!

Complex

-

\

Complex

.
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2.13.2

To modify the Species within a Complex

You can modify the individual Species inside a Complex box at any time. For example, you can add a
residue, change the residue status, or change the name or the class of the Species.

- Note: The Notes information of the individual Species will be maintained even though you move the Species

in and out of the complex box.

- See also: “5 Species---Protein, Gene, RNA and asRNA”

2.14 Complexes and Reactions

A Reaction can be connected to a Complex or to an individual Species/Reaction inside the Complex.
Thus, you can distinguish if the activation is initiated by the Complex, or by an individual Species
inside the Complex.

2141

1.

2.
3.
4

To change the appearance of a Complex

Select a Complex and type “C” to make it compact.

Type the “C” key again to have the border line invisible. (no border)

Type the “C” key again to get back to the original shape.

You can do the same steps as above by selecting Component - Change Complex View menu.

Protain D Protein D

S

Protain A

| Protein B
————— " B ____ ; ‘:
Protein C i[ ProtainD |! FralginD i

complexx | T

r—

“compact”

- Note: You can set a Complex to be displayed with no border. This option is useful when you create a Complex

with Gene/RNA/Antisense RNA inside. Below is an example which you can find in CompTex42.xm1 in
/samples/notation folder.

TH jEeeeeseeeee ! TF1
c Erm:nlex_GeneE
EEER L : =S
Complex_Gene_A
Compact Mo harder

- Note: A Complex can be contained within another Complex. Below is an example which you can find in

components4.xml in /sampTes folder.

q 3
Cpding Region Regulatory Region
Gene B

Complexfiu,Cal®)

Gene_Binded
a normal Complex a compacted a Complex (the blue box) contained
Complex in another Complex
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2.15 Macros

To draw the diagram easier, some of the most frequently used components sets are available as
“macros”. You can select the macros from the tool bar to draw the following components set.

e QL wm &G0l ®® 2 2
- See also: “6.12 Macros”
2.16 Edit Reactions

2.16.1 To change connection points of Reaction on Species

A Reaction can be connected to one of the 16 connection points around a Species.

1. Select a Reaction and try to change the connection point.

. e T

= I I

--.---{.:-- o

2.16.2 To add Anchor points

You can add and remove Anchor points by the right click
menu. ) : '+ v I
\' a4

1. Click a point on a Reaction where you want to

add an anchor. To ('..)r‘lhoqnnal

2. Click the right mouse button and select Add Change Identity.
AIIChOI' Point Edit Reaction.,

) . Edit KineticLaw...

3. See a new anchor point has been added. Reaction Notes..

Change Color & Shape...
- Add Tex‘
52 Import KineticLaw from SASIO-RX_.,

Search papers from .. >

4. 'To remove the anchor point, click the right
mouse button on the target anchor, and then select Remove Anchor Point.

2.16.3 To move a Species with a Reaction

1. Select a Species with a Reaction attached,
2. Move it around and see the last segment of the Reaction follow the Species.

o~ K T I
f’ h ' * |
1 [

2.16.4 To change the shape of a Reaction line segment

1. Select a Reaction
2. Click the right mouse button and select To Orthogonal or To Polyline.

EN
Orthogonal Polyline
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2.16.5

1.

To adjust a Reaction line automatically

Select a Reaction which has alreadly been set To Orthogonal.

KR
= L

2. Right-click your mouse and select Adjust Connection in the menu.

2.16.6 To change line width and color setting of a Reaction

1. Select a Reaction.

2. Right-click on it and select Change Color & Shape... 28 from the context menu.
3. Change the color and line width.

- Note: The color and line width of Species and Compartments can be changed in the same way.
To make areversible Reaction

1. To make a Reaction reversible, double-click the Reaction
2. On the Change property of the reaction dialog box, set Reversible option to True.

Hyme |
Tope [sTaTE_TRANSTION =l
Reversble % True " Ealea

| 0K | Gancel I

2.17 Change Color and Shape of Components

You can change the color and shape of a component individually or collectively.
2.17.1 To change the default settings of the color and shape

1. In the Menu, select Preference — Components Color & Shape.

| 108 % Chaerwt | |CF Tucmd |

|| 4= trow Tt Omend

J 1 bromn Torarton

I A3 Faesectint

| o —

NI

| & Unbeose Cwlaba i
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| | Unksosn Iukeion

| A Mdieion
Fde wl hd

| = Postve Wrarse
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2. Click the icon of the component whose color or shape you want to change.

2.17.2 To change the color and shape of the individual components

1. Select the component(s) to edit, and then click the icon of ES | (Change Color & Shape) in
the tool bar.

2. In the Change color and shape dialog box, change the values as you like.
T S — -]

- e
N e o
Lim
tan | o o
) Puer
€ Debone
ot
o
Smeber figal nal

-V T S

2.18 Export Image

2.18.1 To export the model image in PNG, JPEG, EPS, SVG or PDF format

1. Select File — Export Image... on the Menu bar.
2. Specify the name and the file format.

- Note: The image saved here is the same as the one displayed on the screen.

2.19 Add Model Description

Before you save your model, you can add the description / MIRIAM information to the model.

2.19.1 To add Model Description

1. Select Component — Model Description menu.
The Model Description dialog will display.
2. Specify Creator information, File information to a new model.

- For adding MIRIAM information, see also “8 Notes and MIRIAM annotation”.

2.20 Save a Model

CellDesigner stores all the information on the model you create to an SBML format file.

2.20.1 To save a model

1. Select File — Save or Save As....

- Note: CellDesigner's specific functions will be stored under <annotation> tag in the SBML file.
2.20.2 To save amodel in a pure SBML format

1. Select File - Export Pure SBML Level x Version x....

- Note: Naming Convention
The Model ID or/and the File Name only accept the following characters:
(_I[a-z]I[A-Z])(_I[a-z]I[A-Z]|[0-9])*. No blank space is accepted.
This is the SBML convention.
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2.21 Import a Model

2.21.1 To import an SBML file:

1. Select File - Open.
2. In the Open dialog, select a .sbml or .xml file.
3. Click Open.

2.22 Export a Model

CellDesigner supports export the model to SBML (.xml).

2.22.1 To export amodel to a pure SBML file (.sbml, .xml)

1. In the Menu, select File - Export Pure SBML Level x Version x....
2. Save dialog opens. Specify a file name and Click Save.

- See also: http://sbml.org/ for more details on SBML Levels.

CellDesigner’s file format and pure SBML file format:

CellDesigner stores all information in a SBML file format. While pure SBML format
does not support layout information, CellDesigner stores layout information inside
<annotations> tags in SBML, which is CellDesigner specific extension.

When you export the model into “pure” SBML document, the exported SBML file doesn't
contain any layout information. You may use this feature if you find any trouble when you
tried to open your SBML document with other SBML compliant software.

2.22.2 To export amodel to a BioPAX format file (.owl) (change in Ver4.2)
There is a plugin to export BioPAX format file (.owl). Please install the plugin if you wish to convert
CellDesigner model to BioPAX format file.

- See also: http://www.celldesigner.org/plugins for mode details on CellDesigner plugins.
- See also: http://www.biopax.org for more details on BioPAX levels.
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2.23 Open an SBML File

You can open an SBML file with CellDesigner.

When you retrieve an SBML file created by some other tool than CellDesigner without any layout
information, it will automatically adjust the layout of the model with the layout schemes.

- See also: “6.13 Automatic Layout”
2.23.1 To open an SBML file:

1. Select File - Open, then specify the target SBML file.
- Note: You can also import the SBML models from BioModels.net database. (http://biomodels.net)

- See also: “9 Connect to External Databases”

2.24 Save SBO Terms

The Systems Biology Ontology (http://www.ebi.ac.uk/sbo/) is a set of controlled vocabularies and
ontologies tailored specifically for the kinds of problems being faced in Systems Biology, especially
in the context of computational modeling.

CellDesigner can save the SBO Term automatically.

2.24.1 To save a model with SBO Terms

1. In the Menu, select Edit — SBO Term Value.
2. Check Save with SBO Term Value option.
3. When you save, SBO Terms will automatically be allocated and written in the model file.
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3. Compartments

3.1 Edit a Compartment

The SBML Level 2 Version 4 specification defines a compartment as follows:

“A compartment in SBML represents a bounded space in which species are located. Compartments
do not necessarily have to correspond to actual structures inside or outside of a biological cell,
although models are often designed that way.”

-> See also:
“Systems Biology Markup Language (SBML) Level 2: Structures and Facilities for Model
Definitions” found in http://sbml.org/Documents/Specifications

3.1.1  To edit a Compartment

1. Right click on a Compartment.
2. Select a menu item from the right-click context menu. See the following pictures for detail.

r N
cl
L

Change Identity...
Edit Information ...
Edit Compartment...

Compartment Notes...

Change Color & Shape...
Add Text

3. Depending on the menu item you have selected, one of the following dialogs will pop up.

4. Change identity of FJ Change identity of the compartment [
the compartment
dialog FaE o
QK ] [ Cancel \
5. Compartment [ compartment (e |
dialog
id ol
name cl
campartment Tvpe v:

zpatialDimensions |3

size 10

units :volume -
outzide default

conztant @ true ) falze
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6. Edit Information [ Edit Information [
dialog
state gmpty =
prefix |pc
label T

[ 0K ][ Cancel ]

- See also: “Species” section of the CellDesigner.org Online Help
http://celldesigner.org/help/CDH_Species_T.html.

See also: “5 Species---Protein, Gene, RNA and asRNA”

See also: “11 Gene / RNA / AntiSenseRNA Structure Expressions”

v
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4. Species---General

4.1 Edit Species

A Species is a term defined in the Systems Biology Markup Language (SBML) and represents an
entity in general used in a model. CellDesigner subdivides Species into several categories, i.e.
Complexes, Proteins, Genes, RNAs, or some other Molecules.

4.1.1  To edit a Species

1. Right click on a Species
2. Select a menu item from the right-click context menu.

[ |
sl Change Identity...
Edit Information ...
Edit Species...
Edit Protein...

Species Notes...
Protein Notes...

Change Color & Shape...
Change Font ...

Add Text

Change Complex View »

- Note: The fourth menu item (e.g. Edit Protein... in the above figure) is content-dependent. It will only be
displayed if the Species is a Protein, Gene, RNA, or asRNA.

3. Select a menu item depending on which value you want to edit. See the following pictures
for detail.
4. Selecting Change Identity... menu will show you Change Identity of the species dialog.

clazz

hypothetical i

hame | |
homomultimer |'I |
protein |S1 hd |
hame | |
type

residues/resions

modification

state |empty Vl

text input | |
[ &pp | [ Fezet ] [ Cancel ]

5. Selecting Edit Information... will show you Edit Information dialog.
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Edit Information @

"]

state

prefix

label

I 0]4 ][ GCatcel ]

6. Selecting Edit Species... will show you Species dialog.

SpPECIES E'
id | |
hame | |
species Tupe [ =
compartment | |
initial. & Amount () Concentration

s |
substancelnits | hd |
has0nlksubstance nits true falze
boundarwCondition ) true (%) false
constant ) true (%) false

I |pdate l ’ Cancel ]

- See also: “Species” section of the CellDesigner.org Online Help
http://celldesigner.org/help/CDH_Species_T.html.

See also: “11 Gene / RNA / AntiSenseRNA Structure Expressions”

On the Draw Area, right-click on a Species to show the context menu.

- See also: “5 Species---Protein, Gene, RNA and asRNA”
9
4.1.2  To change font size
1.
2. Select Change font ....

3. In Change Species Name Font dialog, select a font size.

Chanee Species Mame Font

Preview )
Faont Size

R

[ Default ][ Bpply ][ OF ][ Cancel ]

4.2 Find a Species in the List Area

You can view all the data concerning a Species tab in the List Area. This is useful when you want to

glance over all the Species specified in the model.
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You can swap the column by drag-and-drop.

«
[ Species | Proteins Genes RNAs asRNAs Reactions > —[ NOTE | MIRIAM -
(e ) (o)
class lid | name |speciesType compar... positio...  included | quantit... | initi Species (id=s7, name=CAK;
PROTEIN s2 Cdc2 cl inside Amount 0.0 g M-Phase.xml)
PROTEIN s3  CyclinB cl inside Amount 0.0
PROTEIN s4 Cdc25 cl inside Amount 0.0 Protein (id=p7, name=CAK)
PROTEIN sS PP2A c1 inside Amount .
PROTEIN Kinase X inside Amount
___M_—m
PROTEIN 58 Mik1 inside Amount
PROTEIN 39 Weel c1 inside Amount
- Note: In the Species list, you will only find a Complex even if the Complex contains other Species. Properties
for the contained Species will appear on other lists correspoding to the Species, and not on the Species list.
For instance, if a Protein is contained in a Complex, its properties will appear on the Proteins list.
| Grid Snap OFF
v -
[ Species = Proteins Genes RNAs asRNAs Reactions
( Edit ) ( Export )
class lid name | speciesType |compar... positio... | included | quantit... | initialQuany
COMPLEX s1 sl default inside sl(s2 s3) Amount 0.0
- Note: In the Species list, the “included” column shows the list of Speices included in a complex. For example,

s1(s2, s3) means the complex s1 includes the Species s2 and s3.

4.3 Export Lists to CSV file

You can export the contents of the list into .CSV file format. All the other lists you can see in the
List Area, such as the Protein list, the Reaction list, can be exported to a CSV file.

43.1

—

To export the list

Select the Species tab in the List Area.
Click Export button on the list or select File — Export List to CSV... from the menu bar.

[ Species | Proteins Cenes RNAs asRNAs Reactions Compartments Parameters Functions

class lid | name speciesType |compar... | positio... |included | quantit... |initialQuantity  |sub... :‘hasO.A. |bice | o
COMPLEX s27 Complex(Cyc... cl inside s27(s1s13) Amount 0.0 false false false
COMPLEX s28 Complex(Cyc... cl inside s28(s14 s15) Amount 0.0 false  false false
COMPLEX s29 Complex(Cyc... cl inside s29(s16 s17) Amount 0.0 false  false false
COMPLEX s30 Complex(Cyc... cl inside s30(s18 s19) Amount 0.0 false  false false
DEGRA... s26 a33_degraded cl inside Amount 0.0 false  false false
PHENO... s12 M-Phase cl inside Amount 0.0 false  false false
PROTEIN s3 CyclinB cl inside Amount 0.0 false  false false
PROTEIN s5 PP2A cl inside Amount 0.0 false  false false
PROTEIN s& Kinase X cl inside Amount 0.0 false  false false
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3. The Export Setting dialog will be displayed.
'O 7 Export Setting
Species
E class
™ id
E name
E speciesType
W compartment
E positionToCompartment
E included
E guantity type
M initialQuantity
E substancelnits
E hasOnlySubstanceUnits
E b.c.
W constants
M notes

W MIRIAM

{ ok ) ( Cancel )

4. In the Export Setting dialog box, check the data properties you want to export, then click
OK.

5. The file name is automatically specified as “xxx.csv” in the Save dialog.

6. Click Save to save the CSV file.

- Note: You may use other applications to check the contents of the CSV file.

36



CellDesigner™ Startup Guide

5. Species---Protein, Gene, RNA and asRNA

In this section, we shall edit a Protein, Gene, RNA, or asRNA with modification sites. You can use a
sample file “M-Phase2.xm1” to go through the following steps.

CellDesigner allows you to add modification residues to a graphical symbol of specific Species types
(Protein/Gene/RNA/asRNA). Hence, you can describe a state transition of a Species in such a way
that two graphical symbols of an identical Species with different modifications are connected by a
Reaction. The structure of modification residues, states, and state transitions of proteins are also
stored in SBML Level 2 format with CellDesigner’s extended tags.

The sample model M-Phase2.xm1, which you will find in /samples folder, describes state transition of
“Cdc2,” where there are eight “Cdc2”s. The eight represent different Species, while they are
essentially the same protein. Therefore, CellDesigner should handle data structure describing each
protein in a model, so that several protein-type Species could have references to the same protein
data. This data structure is called “Protein”.

- Note: (New in ver. 4.1) In SBML Level 2 Version 4, a new object called “SpeciesType” is being introduced.
SpeciesType is intended to relate the same type of the Species on the model together. This concept
corresponds to the Ids for “Protein”, “Gene”, “RNA” and “asRNA” in CellDesigner.

5.1 Check and Change the Properties on a Protein/Gene/RNA/asRNA

Proteins tab (and also Genes, RNAs, asRNAs tabs) in the List Area shows you all Proteins (Genes,
ENAS’ asRNAs) and their properties included in the model.

Spwcms | Peatein | dieras | Foihs | asfifias | Besctons | Gongarimans |

E) ey

d | tew | rms |
11 GENEFIC #FC
bE  GENEFIC AL
7 GENEFI 0413
GENEFL 0425
GENEFL L=
GENEFL =

AN Ta.15 S

If you cannot see the Proteins tab in the List Area, click on the right arrow in the upper right corner
of the List Area, and adjust the size of the List Area appropriately.

For an individual Protein, you can view its properties by double-clicking on the Protein row to open
the Protein dialog. In the dialog, you can edit the properties of the Protein, such as name and type,
and also add, edit and delete a residue or a binding region.

- Note: Changes in this dialog will be reflected to all Species referring to this Protein, including those inside
Complexes.

5.1.1 To change the type of Protein

In the List Area, click Proteins tab.

2. Select “Cdc2” in the list and click Edit button.
Alternatively, you can click one of the “Cdc2” proteins on the Draw Area, click the right
mouse button, and then select Edit Protein... menu item.

3. The Protein dialog will appear.

—
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name o2
tpe {cenensc =l
resduss/regens

b l s
|
~ l \Jr.n:

oda block diaeram_ |

wio | ]
4. Select the type of Protein from the drop-down list.

: SEIC\TISIIE{%SR (oauemc ] ~[ OEN&R"-: } Enwc.mrs.]

: }1%% ﬁgﬁpbﬁm uo{l_cmmlou{cmn]:su{]

companmsm

Twie?

5.2 Residue / Binding Region of a Protein/Gene/RNA/asRNA

In the Protein/Gene/RNA/asRNA dialog, you can add and delete residues and binding regions. You
can also adjust the position of the residues and binding regions in the dialog.

résidus Eerding
Paatain | én.u ] I::lfagn:m |

- Note: Changes in the modification of residue status (such as phosphorylated, etc.) should be made in the
Change identity of the species dialog.

5.2.1 To add aresidue/region to a Protein/Gene/RNA/asRNA

1. On Draw Area, right-click on a Protein, Gene, RNA or asRNA.
2. Select Edit Protein/Gene/RNA/asRNA....
3. Protein/Gene/RNA/AntisenseRNA dialog will appear.

@V Protein

name sl

type | GENERIC k44
residues /regions

| add. |

| edit. ]

| del. |

| edit block diagram...

(_Update) fCancte

4. Click add or edit button.

5. In the Modification Region dialog (or ModificationResidue / Binding Region dialog when
editing a Protein), specify the name, type, size, and position.
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O "~ O ModificationResidue/8indingR...
id rs2
name
type residue L]
size O
side ' none $4
angle { >

( Close )

- Note: Name of the dialog is dependent on the Species type.

6. Click Close.
7. In the Protein/Gene/RNA/AntisenseRNA dialog, click Update then Cancel.

- Note: You can also delete a residue or a binding region in this dialog.

- Note: Changes in this dialog will be reflected to all Species referring to this Protein, including those inside
Complexes.

5.2.2  To specify the modification of a residue

Once you add a residue to a Protein/Gene/RNA/asRNA, you can specify the modification status for a
specific Species. To specify the status per Species, use Change identity of the Species dialog instead of
Protein/Gene/RNA/AntisenseRNA dialog.

1. On the Draw Area, double-click a Protein/Gene/RNA/AntisenseRNA which has a residue.
Or, select Change Identity... from the right-click context menu.

2. Change identity of the species dialog will open.
® ~  Change identity of the species '

class | PROTEIN )
hypothetical O

name (equals the name of protein)
homomultimer 1

protein | Cdc2 14
name Cdc2

type GENERIC

residues/regions

add..

. Thr14 Thr167
eqit.. TVI’15
del..
modification | empty 144
state v_empty |
: phosphorylated || |
textinput acetylated
e—— biquitinated
\ [ &
1—"3??—'!—4[* methylated
| hydroxylated |
ol glycosylated A F
cl myristoylated v jount
3. In the dialog, click on the target residue in residues/regions (or regions) diagram in the
middle.
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4. Select a modification type from the modification drop-down list.

Phosphorylated - -
Palmtoylated {nco:s S m% TR
Acetylated
Prenylated & (B
Ubiqutinated Acehiated Prenylated
Protonated @ Z@
Methylated Ublqutinatad | | Protonated
Sulfated L
Hydoxylated &) WO,
Empty Methylated Sulfated
Glycosylated o O
Don’t care Hydroxytated empty
Myristoylated - J L
Unknown © O
Glycosytated Donl Care
N &
> Note: You cannot add, edit, or delete modification residues in this Change et | AARROM)

identity of the species dialog. To add/ delete a residue, use
Protein/Gene/RNA/AntisenseRNA dialog instead.

5.3 State of a Protein

”» o«

The state of a Protein can be changed to “open”, “close” or “user defined text”. Here again, you will
use Change identity of the Species dialog instead of Protein dialog.

- See also: “2.9 Activate a Species”
5.3.1 To change the state of a Protein

1. Double-click on a Protein to open Change identity of the species dialog.
2. In the state drop-down list, select an option from empty, open, closed or user defined text.

5.4 Add Notes to a Protein, Gene, RNA or asRNA

Protein/Gene/RNA/asRNA Notes allows you to enter additional text information and save it in the
xml file.

- Note: Each Protein, Gene, RNA or asRNA has the Species Notes as well as the Protein/Gene/RNA/asRNA
Notes. You should be careful which Notes you want to change when editing.

- See also: “8 Notes and MIRIAM annotation”
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5.5 Block Diagram —to check Relationship of a Species (*Proto-type)

Block diagram gives a summary view of interactions with respect to a specific Species (especially
Protein) and relation between its modification and activity as enzyme. Using this block diagram
editor, complex relations between Proteins can be understood at a glance and the relation between
modification states enzymic activity can easily be constructed.

- Note: The editor is still a prototype and user interface for edittin is not fully functional.
5.5.1  To extract Regulation

CellDesigner extracts the interactions where the Species regulates or is regulated by other Species,
from process diagram, and displays its block diagram.

1. Open M-Phase.xml.
2. Right click on Species “Cdc2” then select Edit Protein menu.
3. Click edit block diagram button and you can see the diagram as shown below.

I ctcebnay entmdog Pretemtd? Xl
OR&GRO®0 OR»
®D@E @GO

— — — — — —— — | Xy &

10

cocts - 4 |
w—1+% |
]

A A leen
D s L () e

R P i S, S
)l
Cyten —{ |

S IL I

WA N [ sl o

At the top side of the rectangle placed in center, states of modification residues of Cdc2 and proteins
that cause change of the states (phosphorylate or dephosphorylate) are shown. At the left and
bottom sides, binding to CyclinB enzymic activity to Lamina are shown respectively.

- See also Kitano (Biosilico 1, No.5 (2003) pp.169—176), For notation details of the block
diagram.

List in the dialog shows all the Species of Cdc2 and Complexes with other Species in process
diagram (column) and their modification states and enzymic activity (row).

55.2 Modifications/Activations Relation

You can edit logical relation between modification states and enzymic activity.

1. Select the symbol “&” and then place them on the diagram.
2. Select the arrow, and link “P”, “&”, “0” and “m”.
3. To delete a placed symbol, select the symbol and click X in the toolbar.

- Note: The arrows represent causal relationship and “&”, “|", etc. are logical operators. Created logical relation
can also be verified by checking consistency with contents of process diagram.

4. Press verify button.
5. Enzymic activity fields inconsistent with edited logical relation are highlighted in red.
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The above figures, the left is depicted by logical relation inferred by Species s29 only and the

enzymic activity field of Species s28 is highlighted. The right is corrected by using the information
of s28. (Note that the way of correction is not unique.)
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6. Edit a Model

In this section, convenient functions for editing models are introduced.

CellDesigner provides several functions that are generally seen in drawing software.

6.1 Cut, Copy and Paste

6.1.1

6.1.2

6.1.3

1.

Ll

-~

To cut and paste a Species

Select a Species by clicking on it.
| ]
=l
O [

On the Edit menu, click Cut. Or type Ctrl-X.

The Species has been cut.

On the Edit menu, click Paste.

The Species reappears.

In the Notes Area, observe that the Notes content is the same as the original.

Note: For Mac OS X, use Command key instead of Ctrl key.
To copy and paste a Species

Select a Species by clicking on it.
[T ]
=
O [

On the Edit menu, click Copy. Or type Ctrl-C.
Paste it on the Draw Area by selecting Edit — Paste, or typing Ctrl-V.
In the Notes Area, observe that the Notes content is the same as the original.

Note: For Mac OS X, use Command key instead of Ctrl key.
To change the identity of a Species

Right click on one of the Species shown in the previous procedure, and select Change
Identity.

If Residues Caution dialog appears, click Close.

The Change identity of the species dialog appears.

In the protein list, click New Protein.

In the name textbox, type any name, e.g. “mySpecies”. Click Apply.

Click No. The name of the Species has been changed to “mySpecies”.

Its 1d has also been changed but not shown.

.

{ mySpecies J

In the List Area, select Species tab.
See that the id and name of the Species has been changed.
Species | Proteing | Genes | RMAs | asRh

(E
clazz pozition.. | id name
PROTEIN |ingide *1 F1
PROTEIN |inside |ls2  |mySpecies|
In the List Area, select Proteins tab.
See that the id (as a protein) and name of the Species has been changed.

id tvpe narme
pri GEMERTC =1
pr2 GEMERIC myapecies

43



CellDesigner™ Startup Guide

6.2 SpeciesAlias

The copy-and-paste action makes a duplicate figure of the original Species. The duplicated figure is
called a SpeciesAlias in CellDesigner’s terminology. Strictly speaking, all of the Species on the Draw
Area, including the original Species figure, are SpeciesAliases, each referring to the original Species
object class. In other words, when you have created a new Species, what you see on the Draw Area
is not the Species itself but an Alias of it. This feature enables CellDesigner to have multiple copies
of the same Species object class on the Draw Area, and make various expressions of a network.

al

6.2.1

process exprassion on the network diagram

as

GDP G aBy

aliazes an alias aliazes

guantitative substances in the <listOfSpecies=

Fig. The Alias Structure of the CellDesigner

—

N ootk

To see the relationship between a Species and a SpeciesAlias in XML

In the Menu, click File — New to create a new model.

Click on any type of Species icon from the Toolbar and place it on the Draw Area.
OO o 0 SO e (D) ¢

Move the cursor and click anywhere on the Draw Area to place the Species you have chosen.
Now you have a model with only one Species.

[ ]

Select File — Save as... in the Menu.

Save the file in XML format.

With a text editor, open the XML file you have just saved.

Find the <celldesigner:listOfSpeciesAliases> tag, under which is a child element that
specifies the Alias of the Species. <celldesigner:speciesAlias id="sal" species="s1">

Near the bottom of the XML file, find the <listOfSpecies> tag which lists up all the Species
in your model.

Find a tag as below which indicates the Species itself.

<species metaid="s1" id="s1" name="s1" compartment="default" initialAmount="0">

- Note: A Complex is a type of Species but a ComplexSpeciesAlias is NOT a SpeciesAlias.
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6.3 Select Mode

:[:%‘:

After you have put a new component on Draw Area, the Select Mode icon - © will automatically
be selected so that you can immediately select and move the component. This is the initial setting of
CellDesigner.

You might want to change this setting so as to create several components on Draw Area first and
then rearrange them as you like.

6.3.1 To avoid the automatic Select Mode

1. Select Edit menu in the Menu.
2. Select Input Repeat.

6.3.2  To switch temporarily to the Select Mode

3. While the Select Mode icon e is NOT selected, hold down the “s” key on your
keyboard.

Select a component and move it.

5. Release the “s” key to go back to the previous mode.

.~

6.4 Select All

6.4.1 To select all the components

1. Select Edit and then Select All in the Menu
2. You can also use Ctrl-A.

- Note: For Mac OS X, use Command key instead of Ctrl key.

6.5 Grouping

In Select Mode, by clicking multiple Species while holding the SHIFT key down, you can make a
temporal group of the selected Species. Moving, cutting, and copying them in a group are available.
If you want the group to be permanent (saved to SBML), use Ctrl-G while the temporary group is
formed. This grouping feature is similar to placing several Species within a Compartment but they
are different. Grouping has no effect on the structure of the model. Therefore, if these two
apparently seem to conflict each other in the Draw Area, “Species within a Compartment” structure
has priority.

- Note: Tags cannot include in a group
6.5.1 To create a temporary group of components

1. Click multiple Species while holding the SHIFT key down.
2. You can move, cut or copy them together.

6.5.2  To create a permanent group of components

1. Click multiple Species while holding the SHIFT key down.
2. Select Edit and then Create Group in the Menu. Or use Ctrl-G.
3. When saved, this group information will be written in the SBML file.

- Note: For Mac OS X, use Command key instead of Ctrl key.
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6.6 Alignment

6.6.1 To adjust the alignment of the components

1. Select the multiple Species you want to adjust.
2. Click Edit menu, point to Alignment, and select an alignment type.
You can also click an icon in the Toolbar.

RBEa eI

6.6.2  To adjust the position of a component by keyboard operation

—

Select a component.
2. Use UP, DOWN, RIGHT, LEFT keys to move the component pixel by pixel.

6.7 Set Grid Snap ON/OFF

Snapping your components on the grid makes it easier to layout the pathway diagram.

6.7.1  To use Grid Snap

1. On the Edit menu, click Grid Snap.
2. To show the grid, click Grid Visible on the Edit menu.
3. 'To change the grid size, click Set Grid Size... on the Edit menu.

6.8 Zoom IN/OUT, Bird’s Eye View

You can change the zoom view of the model by clicking the following icons, J D = B
or use the menu [View] —[Zoom Select] to specify the zoom %.
x

When you create a big model, it would be convenient to use the
Bird’s Eye View to navigate inside the model.

The Bird’s Eye View can be displayed by clicking the icon
(Show Bird’ s Eye View) in the above Toolbar. When you drag the red
square in the Bird’s Eye View, observe that the view of the Draw

Area moves accordingly.

- hee

6.9 Change Color and Shape . F— e —

p——— L

You can change the color and size of the components, such as [ | : e

Species, Reactions and Compartments, individually or to  Gedursn

their default settings. — o
gctes | 0] g0

6.9.1 To change the default settings

1. On the Preference menu, select Components Color & EERrErReRTICRetEaCestaane focert.
Shape.... 5 s

2. In the Default Component Setting dialog, click on a
Species of which you want to change the default
settings.

3. In the Default setting of <species name> dialog,
change parameters.

peta | meh | k] e |
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6.9.2  To change the color and shape of the individual component(s)

1. Select a component, or components of the same type.
2. In the Component menu, select Change Color & Shape..., or Click the Change Color &

Shape icon 2 I in the tool bar.

6.10 Change Species font size

6.10.1 To change font size

1. On the Draw Area, right-click on a Species to show the context menu.
2. Select Change font ....
3. In Change Species Name Font dialog, select a font size.

6.11 Display special characters in Component name

As CellDesigner is compliant with SBML, all names of components in a model must conform to the
SBML convention. CellDesigner 4.1 is compliant with SBML Level 2 Version 1; any character that
can be mapped to UTF-8 encoding can be used for the component names. If you want the special
characters, such as + plus, line break, superscript and subscript, you should follow the special rules
to input such characters.

6.11.1 Examples

A special character is expressed by a sequence of characters with precedent and follow up '_'s. Here
are some examples:

1) Ca2+ ("Ca" with "2+" superscript) Cde2
l Cay ] l +CyclinB ]

Ca_super_2_plus__endsuper_

Ca_super_2+_endsuper_

2) G alpha beta gamma ("G" with Greek "aBy" subscripts)

G_sub__alpha_ beta_ gamma__endsub_
G_sub_aBy_endsub_
3) Complex of Cdc2 and CyclinB ("Cdc2" followed by "+CyclinB" in the new line).

Cdc2_br__plus_CyclinB
Cdc2_br_+CyclinB
For more details on displaying special characters, click Name Expression in the Help menu.
- Note: CellDesigner uses the “name” attributes as information to distinguish Species. Therefore, even if the

rendered names look the same, the different “name” attributes, for example, “Ga” and “G_alpha_”, mean
different Species.
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6.12 Macros

To draw the diagram easier, some of the most frequently used components sets are available as
“macros”. You can select the macros from the tool bar to draw the following components set.
o9 Lw A Gaod @@ 2 2

6.12.1 To view how each macro draws the components

1. In the File menu, click Open.

2. In the Open dialog, go to “samples” folder in your CellDesigner directory.
3. Double-click “Macro.xm1” in the “samples” directory.

MACROS

Macrol: State Transition
u Macro8: Add Catalysis

i

Macro2: Catalysis

(1
Macro9: Add Inhibition
o) s23
s2 (] s2
Macro3: Inhibition
s
L1

Macrol0: Phosphorylation
rsl 24 rsl 24
i - i

Macroll: Add/Edit Residue Modification

O
A\

Macrol2: Transcription
{ 56
Macro5: Dissociation
s47

D,
Macrol3: Translation
s

Macro4: Association

Macro6: ATP_ADP Macrol4: lon Channel

s16 {1 s16
Macro7: GTP_GDP Macrol5: Reaction Target
s19 O s19 s56 {1 s56

6.12.2 To change the Macro Setting

1. In the Preference menu, click Set Macro UlL...
2. In the Macro Ul Setting dialog, change the settings.

6.13 Automatic Layout

Automatic layout function is available for adjusting the model outlook.

When you retrieve SBML files without any layout information created by other tools, CellDesigner
will automatically adjust the layout with its layout schemes.
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6.13.1 To change the layout of your working model

1. On the Layout menu, select one of the layout types
Orthogonal Layout
Organic Layout
Smart Organic Layout
Hierarchic Layout
Incremental Hierarchic Layout
Circular Layout

Tree Layout
Edge Router
i_ 4“-‘
’
e
/A - _r N
| ee———" ]
rd ' xiwh i
“wn | [} ’ vii_}
\ ' bl
o[ ~ o e
o ‘ '
3 Y -~
g e

You can change the detail settings for the above types as well as default settings adopted when you
retrieve SBML files.

The default setting is Smart Organic Layout.

6.13.2 To change the Default Setting:

1. On the Layout menu, click Default Automatic Graph Layout.
2. Select a layout you want set as default.
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7. Reaction and KineticLaw

7.1 Reaction ID

7.1.1 To show Reaction ID on Draw Area

1. On the View menu, select Show Reaction ID.

with Reaction IDs without Reaction ID

7.2 Edit a Reaction

1. Right click on a Reaction.
2. Select a menu item from the right-click context menu.

Add Anchor Point

Remove Anchor Point

Adjust Connection
To Orthogonal

Change Identity...

Edit Reaction...

Edit KineticLaw...
Reaction Notes...
Change Color & Shape...

Add Text
Import KineticLaw from SABIO-RK...

Search papers from ... »

3. Select a menu item depending on which value you want to edit.
4. Selecting Change Identity will show you Change properties of the reaction dialog.
A  Change properties of the reaction

Name [,

Type | STATE_TRANSITION 44
Reversible () True () False

oK) ( Cancel )

5. Selecting Edit Reaction will show you Reaction dialbg.
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. "ol Reactio
id rel
name
reversible | true  * false
fast (O true @ false

[ listOfReactants | listOfProducts  listOfModifiers |

Edit ( Export )

alias |species | stoichio... _stoichiometryMath
sal sl 1.0
| €8 5 <>

KineticLaw
Update ( Close )

6. Selecting Edit KineticLaw... will show you KineticLaw dialog. See “7.4 KineticLaw" for
detail.

- See also: “Species” section of the CellDesigner.org Online Help
http://celldesigner.org/help/CDH_Species_T.html.
-> See also: “11 Gene / RNA / AntiSenseRNA Structure Expressions”

7.3 Reactions List

You can view all the data concerning a Reaction in the Reactions tab in the List Area. This is useful
when you want to check all the Reactions specified in the model.

You can swap columns by drag-and-drop.

Soed-l hohml&nul anl adﬂhl Reactions | Ga-umml Mlﬁu&nl Uitz | ﬁabl Emnl

Species 1D lu!!lml

% < id | rame [rovee | fast | reoctants | products | moditwrs | math
o“ff TRANSITIO_ | () fase faise |MKKK  MKKKP  (MAPKPP V1 ® MKKK / (0 + powMAPK PP / Kue)) » (61 » Mm))
STATE TRANSITO_|J1 (01 lfaise [false  MKKKP |MKxK [ V2« MKKK P / (KK2 + MEKK P)
STATETRAMSMO_ |2 |2 ffake [falbe MKK  MKKP  MKKKP k3o MKKKP® MKK /(0CK3 o MKE) 3
STATE TRANSITIO |G |03 fskes faiee |MKKP  MKKPP  IMKKKP  Kké * MKKK.P & MEK P / (K& + MKK P)
STATE mmsmo [ 13 fake [fate MK PP MKk P | V5 * MKE PP / (K5 + MKK PP) |
STATE TRANSITIO. |6 (6 flakse nogo m: 13 |MEX | _ [V » MKE P/ (XKh + MKK_P)
STATE, mmsrm 1816 lfalse lfatee |MAPK |MAPK P [mrx PP K7 % MKK PP * MAPK / (KK7 + MAPK)
STATE TRANSTO_ |37 [J7 " ltake lfale IMAPKP  IMAPKPP IMKK PP B+ MEKPP + MAPK P / (KB + MAPK 9
STATETRANSITIO_ |8 |0 false |lskee |MAPKPP  MAPKP | [V % MAPK PP / (XK3 + MAFK PP}
STATETRANSITIO_|8 |8 lfake false |MAPKP [MaPK 1 V10 MAPK_P / (kK10 » MAPK_P)

You can export the contents of the list into .CSV file format by clicking Export button on the top of
the list.

7.4 KineticLaw

You can specify a KineticLaw to a Reaction using the KineticLaw dialog. You can input your own
math functions, or you can use the predefined functions from the KineticLaw dialog.
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7.4.1 To add a KineticLaw to a Reaction

1. Create a model with Proteins A and B, with a State Transition Reaction in-between.

-

2. In the List Area, click on the Species tab.
3. Select the row for the Protein A.
4. Double click on the cell under InitialQuantity column.
5. Set the value to “0.1”.
Spaciea | Proteins | Genes | RNAz | saRNAs | Resctions | Compartments | Parameers | Furctions | Units | Futes) 211
&8t | Export|
clots onT.| o rame COng s ﬁiﬁu L |hosO.| be [cha

F?p'tn >‘ 2 B !.‘h Amant DO | falsn falsn 0

6. In the List Area, click on the Reactions tab and double click on the STATE_ TRANSITION
Reaction to open the Reaction dialog.

7. Click KineticLaw Create button.

8. Instead of doing the steps 6 and 7, you can also click on the Reaction with the right mouse
button, and then select Edit KineticLaw... menu.

" | et a0
Add Anchor Point

Eait Raaction

Imgort KineticLaw from SARD-8X

Search papers rom .

9. The KineticLaw dialog will open.

rath

[Beoge I+ [ - T = L+~ W ¢ 1 1 |

[nyss

[ SelectuRuaction

)——{)

lII Pradeires Functons

Mazz_Achon [ rabcr
Tesetenbie Tinphs Weohse bi-Wenien

Specwr  Paramaies | Fuis

clazz ] rarm mecmaTpe  corpat pardion.  rohded quandite_ 1
FROTER fri & nfua iz e Arcurd 117
FROTER 3 £ nfua iz e Arcurd 10
< 3
;‘bﬂl
10. In the Predefined Functions pane, click Mass_Action_Kinetics.
[w ] Fredeimed Funceons

HorFredefradFurcion

et bl Toempie Maohs o= Fenin

U= I'HS.

11. The Formula dialog will be displayed.
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1

X

Faormula
v==kK H Si
i
51 =1 |
k | |
[ 0] ][ Cancel ]

12. Enter “0.3” in the k text box, then click OK.
13. See that “s1*k1” has been entered in math field, then click Update, then Close.

math | <1#k1

= copy +

[] Math
[ ] Hame

14. In the Reaction dialog, click Close.

The KineticLaw for the Reaction was successfully set.
Now you can run the simulation.

7.4.2 To run the simulation

1. Do the previous walkthrough “To add a KineticLaw to a Reaction”. Or, just open the file
siml.xm1 in the samples folder.
2. On the Simulation menu, click Control Panel.
3. In the Control Panel <filename> dialog, set End Time to “20”.
4. Click Execute button. You will obtain a graph like this.
i Simdateg
eerav
: Tims cpan Frror Aabwran Sotrer :.;,v, Tuse
£ T 20 2 BOsse - , B BRoeies TlRse 1P e ol & G|
R a:"rmu -~ e 60 coPas rlrlla«..l.n e S ogeciet [ Fhwes ] Fmeemirs [ Compateerts o U"f a -
P - - - - i s, G
Soecier | Parsrweiws | Change amoum | Parsewns Scan | Sieretws Sowiletan  feauts
L) MNave Congartn Cuantiy T ol Qua.  Substwse.  toundwy aoe
) A detat Aot (T sdatorcs tadse
%2 2] et Aot Ulstatance  Taies
a4
{91000
. L 0 10 " "
= 2 Comwt )
| hmakee Sane ko | Eoncuts |__§_r_‘:_j _Iahow saatie plot
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8. Notes and MIRIAM annotation

There are two ways to annotate a Component (Compartment, Species, or Reaction); by adding free
text Notes and by adding MIRIAM information.

The Notes allows you to enter additional text information for your Component and save it in the
xml file.

- Note: Each Protein, Gene, RNAs or asRNA has a Protein/Gene/RNA/asRNA Notes as well as Species Notes.
You should be careful which Notes you want to change when editing.

The Notes should be written in XHTML format. For details on XHTML tags and attributes, please
check the XHTML 1.0 specification provided at http://www.w3.org/TR/xhtml1/

You can enter PubMed ID in the Notes, and directly link to the relevant reference.

- See also: “9 Connect to External Databases”

MIRIAM (the Minimal Information Requested In the Annotation of Models) is a standard to
annotate and curate computational models in biology. http:/www.ebi.ac.uk/miriam/. SBML Level 2

Version 4 recommends using MIRIAM as an annotation scheme. CellDesigner 4.1 now supports
MIRIAM annotation.

MAPK42 .xm1 is a sample file installed with CellDesigner. The file already contains MIRIAM
information to give you a picture of how MIRIAM information is added on a model.

8.1 Notes

8.1.1 To add Notes to a Component (i.e. Compartment, Species or Reaction)

1. Select a Component.

2. Click on the right mouse button to display the popup menu and select Species Notes...
(Compartment Notes... or Reaction Notes...).

3. Or, click NOTE tab in the Notes Area (at the bottom right corner of the Main Window) and
click Edit Notes button.

- Note: If you select a Protein, Gene, RNA or asRNA, you will also find [Protein | Gene | RNA | asRNA] Notes
menu item in the right-click menu, as well as Edit [Protein | Gene | RNA | asRNA] Notes button in the Notes Area.
See the next procedure “To add Notes to a Protein, Gene, RNA or asRNA” on how to use them.

4. See that the Species Notes (Compartment Notes... or Reaction Notes...) dialog pops up.

"‘. Species Notes (d=57, M-Phasexml
Chtmd xembss” hitp//erewy w3 0ce 1990/t ™>

e |
5. Type the text you want to add in XHTML format.
6. Click OK to close the dialog
7. See the Notes information you have just added is displayed in the Notes Area.
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Edit Mobes | Edit Protein Motes |

pecies (i0=s7, name=CAK; hM-Phase oml)
Specais Motes: For Datads, plage check colldesignes, crg

vl 1d=pd | rmes CAK)
Thiz & Feoles Moles of CAK

8.1.2 To add Notes to a Protein, Gene, RNA or asRNA

If your target Species is one of the following types, namely, Protein, Gene, RNA or asRNA, you can
add the [Protein | Gene | RNA | asRNA] Notes as well as the Species Notes.

1. Select a Protein, Gene, RNA or asRNA.

2. Click on the right mouse button to display the popup menu and select Edit [Protein |
Genes | RNA | asRNA] Notes, or click Edit [Protein | Genes | RNA | asRNA] Notes
button in the Notes Area (on the bottom right corner of the window).

3. [Protein | Genes | RNA | asRNA] Notes dialog pops up.

EProlmn Notes (Gd=prl. untitied sbml)

il xming="http 7/ Sowwn w3 org /1998 Sl >
ody>
Chody>
mbd
oK | Cancal |

4. Type the text you want to add in XHTML format.

5. Click OK to close the dialog

6. See the Notes information you have just added is displayed in the Notes Area.
Edit Mates | Edit Protein Mates |

pecies (id=s7, name=CAK; M-Phase, oml)
Speceis Mobes; For Detads, plase check celldesignes, org

rirlgn =g | lme=CAK)
Thiz is Protesn Moles of CAK

8.2 MIRIAM annotation

8.2.1 To see MIRIAM annotation on a sample file MAPK42.xml

1. In the Menu, select File, then Open.

2. In the Open dialog, find MAPK42.xm1 in /<your CellDesigner directory>/samples/ folder
and Click Open.

3. MAPK42.xm1 opens. We shall modify this file, so if you wish to keep the original file, make its
duplicate.
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4. Select a Component, e. g Reactlon “J7.

5.

6.

8.
9.
10.
11.

12.

In the Notes Area, click MIRIAM tab. To have a wider view, click the left-pointing arrow.
L] P4 NOTE £ MIRTA
g —

|Rea|:t, ion (id=J7, name=phosphorylatio

MIRIAM information on the Reaction “J7” is displayed.
M‘ MIRIAM |
[ ok | [ AddRelation | [ Add DataTwe | [ Remove | [ #ccess | [ Glear Al |
Relation DataType [}
babiolthasVersion Feactome REACT 2247 ]
babiolthasVerzion Reactome REACT 136
babiolizWersionOf Enzyme MNomenclature 23122
babiolizWersionOf Gene Ontology GC-0000187
bobioliz'WersionOf Giene Ontology GC-0004708
bobioliz'WersionOf Giene Ontology GC-0006468

Select the first row where Relation is “bgbiol:hasVersion”, DataType is “Reactome” and ID
is “REACT_2247".

NOTE| MIRA,
[ ok ][ Add Relation | [ Add DataTwpe | [ Remove || Access | [ Glear &l
Relation DataTvpe ID
Reactome
babiolthasVersion Feactome REACT 136
|bqt-ic-|:is‘\.-‘ersion0f |Enzyme Mamenclature |2.'.".12.2 |

Click Access button, and a pop-up menu will appear.
In the pop-up menu, select “MIR;00100026”.

Your web browser will be launched and show you a Reactome web page explaining “MEK2
phosphorylates ERK-2 [Homo sapiens]”.

Back to CellDesigner Main Window, in the MIRIAM list, select the third row where

Relation is “bgbiol:isVersionOf’, DataType is “Enzyme Nomenclature” and ID is “2.7.12.2”.
Click Access button, and a pop-up menu will appear.
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13. In the pop-up menu, select one of the followings:
“MIR;00100001” to access an EBI web page
“MIR;00100002” to access a KEGG web page
“MIR;00100003” to access an ExPASy Proteomics Server web page
14. Whichever web page you go to, you will find information on Mitogen-activated protein
kinase kinase (EC 2.7.12.2).

8.2.2 To add MIRIAM information to a Component

—

On the Draw Area (Canvas), select a Component (i.e. Compartment, Species or Reaction).
2. Click on the MIRIAM tab in the Notes Area.

NOTE | MIFIAM |

Felation

w

Click Add Relation button.
4. A Relation will be added to the list.

WMOTE | MIRIAM |

| ok || Add Relation |

Felation DataTupe

5. Click on the Relation field. Select a Relation from the pull-down menu (e.g.
“bgbiol:isVersionOf).

Felation DataTwpe

bobiokizWersionO f bl BIMD

bgmodeliz s
bgmodelizDezcribedBy

babializ

bobiokhas Part

DataTvpe

BIMND

BIMD

ShEEIL

Enzembl

Enzyme Momenclature
IIniProt

Taxonomy

BioModelz Databaze
MIFIAM Resources W

7. Double-click on the ID field. Enter an ID (e.g. “P26696”).

- Note: If you do not know the ID, click Access button. It will show MIRIAM site IDs, select one to access the
website and find the ID for the DataType.

8. Click OK to save the MIRIAM information.

1) 4
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8.2.3 To add a new DataType for an existing Relation

1. Select a Component which has MIRIAM information.
2. In the Notes Area, click MIRIAM tab.
3. Select a Relation from the list.
Relation DataTvpe ID

VerzionOf LniProt
4. Click Add DataType button.
5. A new MIRIAM entry of the same Relation will be added.

Relation DataTvpe ID
bobiolizWersionO UniProt P2G6696
bobioliz'erzionOf LkiPrat

6. Click on the DataType field and select a DataType from the list.

Relation DataTupe ID
bgbiolizVWersionOf UniProt P26696
|:||:||:|i|:||:i:£:" = niProt W -

BIMD A
ShEEL 3
Enzembl
Enzyme Momenclature
UniProt

7. Double-click on the ID field and enter an ID for the DataType.

8. Click OK to save the MIRIAM information.

8.2.4 To delete MIRIAM information

Select a Component having MIRIAM entry. of the same Relation.
In the Notes Area, click MIRIAM tab.

Select an entry to delete.

Click Remove.

Ll

- Note: If you want to undo the Remove action, just click the Component on the Draw Area without clicking OK
button. MIRIAM information for the Component will not be saved until you click OK button.

5. Click OK to save the MIRIAM information.
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9. Connect to External Databases

You can connect to external databases using the Species name or ID specified in the Notes.
Currently we support the connections to the following databases.

Importing models and information

BioModels.net

http://www.biomodels.net,
http://www.ebi.ac.uk/biomodels/

JWS Online

http://j3).biochem.sun.ac.za/

PANTHER Pathways
database

http://www.pantherdb.org/pathway/

SABIO-RK

http://sabio.villa-bosch.de/

Use Species Names for

query

DBGET

http://www.genome.jp/dbget/

a simple database
retrieval system for a
diverse range of molecular
biology databases

SGD http://yeastgenome.org/ Saacharomyces Genome
Database
iHOP http://www.ihop-net.org/UniPub/iHOP/ Information Hyperlinked

over Proteins

Genome Network
Platform

http://genomenetwork.nig.ac.jp/public/sys/gnp
pub/portal.do

Use IDs for query

PubMed

http://www.ncbi.nlm.nih.gov/sites/entrez

*MIRIAM support

Entrez Gene

http://www.ncbi.nlm.nih.gov/sites/entrez?db=
gene

UniProt http!//www.uniprot.org *MIRIAM support
ChEBI http://'www.ebi.ac.uk/chebi/ *MIRIAM support
MetaCyc http://www.metacyc.org/

Gene Wiki http://en.wikipedia.org/wiki/Portal:Gene_Wiki

Panther Web http://www.pantherdb.org

9.1 Database Query

911

W=

To use Species Names for database query

Select a component (Species, Reaction or Compartment).
In the Menu, select Database, and then Connect to <database name>.
See your web browser pop up and open the page relevant to the Species.

Note: In case of DBGET, search is conducted according to the format of the name. If the name is written as

“2.1.3.1”, “EC2.1.3.1”, “EC: 2.1.3.1”, and “EC 2.1.3.1” for EC number, while the name start with “C”, “C00010”,
“C 000107, “C: 00010”, search for compound ID.

9.1.2

—

To use PubMed ID and Entrez Gene ID for database query

Select a component (Species, Reaction or Compartment).

2. In the Notes Area, click Edit Notes.
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3. Specify the PubMed ID / Entrez Gene ID / UniProt ID as follows:

PMID:12345
PMID:67890
GenelD: 22954
UniProtID: Q13049

HSpecies Motes f{id=s1; untitled}

<html wmine="httped Aom w3 ore 999 5kt m
{body>

GenelID:22954
UniProtID: @13044
PHID: 12345
PHID:GTE0

</hody
<htmle

L ] 3 ” Cancel ]

In the menu bar, select Database - Connect to PubMed.

Your browser will be launched and show the PubMed web site.

In the menu bar, select Database - Connect to Entrez Gene.

Your browser will be launched and show the Entrez Gene web site.
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No ot

IHAD MRD BT RN 24D AN

JETTEO B & = ot
DO ek dim ] )= | SR WN ool
Cymode Tows Sumt Datstmies sk | Pg_1 _roies_set_somd

3
$) Soeces 560 YHROZIW l YERDS4C
W) Neactona

Lamit Prevesinoe 000y CApOOM o Detany

OREY 2122 EC21 4
EC aumber

£c212) [

EC 2135
DBGET . "
compaunt O ol $0900 £

Diuplay | Fowtract
[ A= 1 Pe— %

translocation and phosphorylation of Elk-1

Apln AE, Stewart SA, Assoian RK, Julano RL

Skl slfson s =hoeman =)
[ 1: 3 Coll Bint 2001 Apr 15153232732 Falated A

Integrin-mediated adbesion rogulates ERK nucloar

Department of Pharmacolegy, School of Medcitg, University of North
Carnbon ot Ohumal HE Charal I A ah l“r\ V-\T‘T'n:lQ 1S4

Wrdm SEW Bewexe b ppingy JR) 17 e ity rimnih v favre/ umey fca s mde et wvedcbimpabmadibdopts Moo acth bt sarder 1 A0S :]‘

PoliMet

v | L |

Paact ion (i rel, rasess Ouludanes. )
we B0 Pydle SH47EE Padlc MRS
Pwiic 1

Fwilc EERES) Pwllc 11380400

e, U2 PYOEc BR4ETRE Pilc s
Fwitz 1228579

Wile WISESST Pwilc TINRIASSS

L (U): Pudle SR4E7Rf Pullc 1000840

M

4 1

9.2 Importing Models and Information

9.2.1 To import models from BioModels.net

BioModels Database (http://biomodels.net) is a data resource that allows biologists to store, search

and retrieve published mathematical models of biological interests. Models present in BioModels
Database are annotated and linked to relevant data resources, such as publications, databases of

compounds and pathways.

1. In the Menu, select Database, then Import model from BioModels.net...
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The BioModels.net dialog opens.
Select a model in the list and click OK.
If Notice dialog opens, just click OK.
The model will open.

A

- Note: In step 3 above, you can also search models by name. When you put any letters or numbers to Search
box , only the models which have the letters or numbers in its name will be listed. It performs a
case-insensitive search.

1D Mame
BIC MDOO000000 & Gioldbeter! 995 _CircClock
BIO MDOOO00000Z1 Leloup! 999 CireClack
BIC MDO000000022 Ueda2001_GircClock
BIO MDOOO00000Z24 Scheper1999_ CircClack
BIC MDO000000025 Smolen2002_CircClack

BIO MDOOO000D034 Smolen2004_CircGlock

BIC MDOOO0000035 Tyzon1399_ CircClack

BIO MDOO0000D0SS Locke2005_CircadianClock

BIC MDOO0O0000073 Leloup2002_CircClock_DD

BIO MDO0O0000074 Leloup2003 CireClock_DD_REV-ERBalpha
BIO MDOO0000007S Leloup2003_CircClack_LD

BIC MDO0000000S3 Leloup2003_CircClock_LD_REV-ERBalpha

BIO MDOO0O00000SS Locke2006_CircClack _LL

BIC MDO000000160 Hie2007_CircClock

BIO MDOOO00001 71 Leloup1 998 _GircGlock_LD

BIC MDO0000001 85 Locke2008_Circadian Clack

BIC MD0000000201 Goldbeter2008_Somite_Segmentation_Glock_Motch_ Wint_FGF

BIO MDOOO0000Z214 Ak man2008_Circadian_Clock_Model2
BIO MDO0O0000216 Hong2009_CircadianClock

Search box

Description | Reference Iclock Import | Cancel |

9.2.2 To import models from pantherdb.org

Panther Pathway Database (http://www.pantherdb.org/pathway) consists of primarily signaling,
pathways, each with subfamilies and protein sequences mapped to individual pathway components.
Pathways are drawn using CellDesigner, capturing molecular level events in both signaling and
metabolic pathways, and can be exported in SBML format. The images of SBGN view of the
diagram can also be exported.

In the Menu, select Database, then Import model from pantherdb.org...

The pantherdb.org dialog opens.

Select a model in the list and click Import.

If 1ibSBML Consistency Check dialog opens, read the message and click OK.

If File conversion needed dialog opens, read the message and click Yes or Cancel. Even if

you click Cancel, you can still open the model.

If Notice dialog opens, just click OK.

7. If Compartment's size attribute is undefined. dialog opens, click OK or No. Even if you
click No, you can still open the model.

8. The model will open.

Ot oo

12

9.2.3  To import the reaction information from SABIO-RK database

The SABIO-RK (System for the Analysis of Biochemical Pathways - Reaction Kinetics) is a
web-based application based on the SABIO relational database that contains information about
biochemical reactions, their kinetic equations with their parameters, and the experimental
conditions under which these parameters were measured. It aims to support modelers in the
setting-up of models of biochemical networks, but it is also useful for experimentalists or
researchers with interest in biochemical reactions and their kinetics. Information about reactions
and their kinetics can be exported in SBML format.

- See also: “7.4 KineticLaw”
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1.

Import the model TCA cycle from pantherdb.org. We will use the model as a sample
throughout this walkthrough.

'_':(nm!u-uh org

Parse
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TOORC 00 1004100 by DZIP barsir D70 tacher -

- See also: “9.2.2 To import models from pantherdb.org”

2.

© XN Ok W

On the Draw Area, select r20.

Qxalo®etate

In the Menu, select Database - Import reaction information from SABIO-RK...
The Import kineticLaw from SABIO-RK dialog will appear.

Verify that Malate Dehydrogenase is already been typed in Search query textbox.
Click Search button.

In the Confirmation dialog, click Yes.
From the returned list, select a row where id is 14888.
KineticLaws will be displayed.

St - T I ot

| e tanads

IMJ.b M Vissz* M Eean)

{h—w

[ . [—
% —

10. In the Import kineticLaw from SABIO-RK dialog, click Import KineticLaw.
11. Mapping SpeciesReferences ID dialog will appear. Imported data from SABIO-RK is

displayed on the right side of the dialog.
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12.

13.

14.
15.
16.
17.
18.
19.

T e ] |
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If necessary, click Swap Reactants/Products to exchange the imported Reactants and
Products.
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Confirm that the type of each Species on the left side (CellDesigner side) meets that of the
right side (SABIO-RK side). If not, select another Species from the drop-down list.

Click Apply.

In the Confirmation dialog, read the message and click OK.

In the Import kineticLaw from SABIO-RK dialog, click Close.

On the Draw Area, right-click on the Reaction r20.

Select Edit KineticLaw from the list.

In the KineticLaw dialog, confirm that the Kinetic Law is successfully imported.
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10. Simulation

This section describes how to simulate a model.
CellDesigner can be used as an SBML file editor for simulators.
There are two ways to conduct the simulation by CellDesigner:

® using Simulation menu to call SBML ODE Solvers seamlessly. The conditions can be set using
the Control Panel directly.

® using SBW menu to call SBML compliant simulators.

= e i = B
' SEEE3
" = 59
Simulation Engine
Simulation menu SBW menu . .
for direct control over SBML ODE solvers. to call SBML compliant simulator.

If you select the Simulation menu, you can call SBML ODE solvers (SOSLib, Copasi, and
SBMLsimulator) directly. The ControlPanel enables you to specify the details of parameters, changing
amount, conducting parameter search, and interactive simulation with intuitive manner.

-> See also:
- SOSLib : http://www.tbi.univie.ac.at/~raim/odeSolver/
- COPASI: http://www.copasi.org
- SBMLsimulator: http://sourceforge.org/projects/sbml-simulator

If you select SBW menu, you can pass the SBML data from CellDesigner to the SBML compliant
simulators via SBW. You can conduct simulation seamlessly from CellDesigner via SBW to evoke
such SBML compliant simulators.

- Note: You need to set up SBW before you conduct simulation.
- See also: “1.2 Install SBW and SBW Modules”

To conduct time evolving simulation, you also need to know some basics of the SBML specification.
This section describes the minimum requirements for simulation.

- Note: There are various annotated sample models at BioModels.net for simulation.

- For more details on SBML specifications,
see also http://sbml.org/Documents/Specifications.

- See also: “9 Connect to External Databases”

- For more details on simulations and parameter handling, see also [Running CellDesigner
Simulation with Control Panel] in ControlPanel42.pdf.
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10.1 Simulation by ControlPanel

10.1.1 To simulate a model using the ControlPanel

1. Open the sample file “MAPK.xm1” in the “samples” folder.
2. In the Menu, select Simulation - ControlPanel.
3. The Control Panel will open.
4. Select Solver of your choice: [SOSlib], [COPASI], [SBMLsim]
5. Change the End Time value to “1000”.
6. Click Execute button.
7. You will see the time course plot in the right side of the control panel.
Ao Cantrol 0
File Stretation
geas
) Tirme apan trror taleranes Savver FGrahs Tabie
Ead Tiw L OMX SOnib i w  Cobw
[ a s COPAS! Comcentration | row 384 ¥ species Thaces Paraminters Comp” B wa
Num, @ 100 13 @ seiLaim 6 298 71 : ::: o=
M ow
I Symcies Parameers » ¥ o .
™ o -
- S " O M ow .
MR MAMY X 000 ( ¥ ow
MR P NAP -7 o wo
) NAPK a0
MNP MAPKK-P Vo 100
KK PP MAPKKE M v 0o
MU NAM 2800
MAM P NAMK-# < wo
MAM. NAMN -9 ool Concenty wn
& oo
N U 3 400 ) L] N o i’
e Urisdect all
; 1000.00 soecies sawch
F—====—7—-= — .« — wmarrth

Innadiow Save As Exwcune Clow show scarser plat

- See also: For more details on Control Panel, please refer to the document “Running
CellDesigner™ Simulation with Control Panel’ found in the /documents folder.

10.1.2 To convert the graph to a scatter plot

1. In the ControlPanel, select any two
Species by ticking the checkboxes in
the Visible column. >
2. Observe that the graph has been .
reduced to two curves.

ScatterChart

3. Tick the show scatter plot checkbox.

4. Observe that in the new graph the .
x-axis does not indicate time series .
any more.

5. Select the reverse checkbox to change
the x- and y- axes.

10.2 Simulation by COPASI

COPASI (http://www.copasi.org/) is a software application for simulation and analysis of

biochemical networks. You can use Copasi engine via CellDesigner’s control panel, or Copasi’s own
GUI.

10.2.1 To setup COPASI to use with CellDesigner
CellDesigner installer provides COPASI libraries. Users do not have to manually download and
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install COPASI library anymore.

For Windows users, please download and install “Visual Studio (C++) 2010 runtime” to use COPASI
from CellDesigner.

10.2.2 To simulate a model via CellDesigner’s Control Panel, changing the solver to COPASI

1. Click the COPASI radio button.
2. Click Execute

10.2.3 To simulate a model with COPASI

1. Open the sample file “MAPK.xm1”.

2. On the Simulation menu, select COPASI GUI
3. The Copasi Time Course Simulation dialog will open.
4. Change Duration value to “1000”.

4 Gopasgi Time Course Simulation [MAPK.xmlil EJ[E|E|

6 Time Course

Duration | 1000 Tntervals 100
Interval Size | 100 Start Qutput Time | 0.0
[ Show Method Parameters... ]
I Fun ” Create Default Report ]

5. Click Run.

6. In the Time Course Result window, compare the result with the section “10.1 Simulation by

ControlPanel".

oscilating MAPY,

-
J

10.3 Simulation by SBW modules

If you want to simulate the model with SBW modules you need to check if the SBW and
SBW-powered simulator modules are installed in the path mentioned in the section “1.2 Install SBW

and SBW Modules”.

10.3.1 To confirm the installation of SBW

1. To check if the SBW is properly installed, start CellDesigner and open a model. The SBW
menu in the main Menu should be activated if your setup has correctly been done.

2. Check if there are any simulators listed in the SBW menu.

3. If you have installed the simulators of your choice correctly, they are listed under SBW
menu.

- Note: “Jarnac Simulation Service” appears if Jarnac has been installed. The others are default-installed.
10.3.2 To simulate a model using SBW component
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—

Open the sample file MAPK.xm1 in “sampTles" directory.
2. In the Menu, select SBW — Jarnac Simulation Service as an example.
This wakes Jarnac up.
3. Check the help or manual of the simulator to learn how to start the simulation.

10.4 Data required for Simulation

For simulation, you should specify at least some Species, Reactions and their attributes. The
minimum requirement of their attributes might be:

Species: -initialAmount (default=0.0),

Reaction: -reactant: -SpeciesReference: -stoichiometry (default=1),
-product: -SpeciesReference: -stoichiometry (default=1),
-kineticLaw: -math,
-parameter,

- Note: the rightmost of each line is required to be input.
10.4.1 Species Attributes

The attribute “initialAmount” should usually be changed to a positive value.

According to SBML Level 2 specification, the attribute “math” should be a text string in which the
1d of Species and the parameters are written. These attributes can be set at the Species list shown
in the List Area.

10.4.2 Reaction Attributes

The attributes and parameters of the Reaction can be specified in the Reaction dialog and their
child dialogs.

For the other parameters, the default values specified in SBML Level 2 are used.

10.5 Simulation Sample: MAPK.xml

Let us use the sample file “MAPK.xm1” to see how the data required for simulation is specified in the
model.

10.5.1 To check the data required for simulation

1. Open MAPK.xm1 in “samples” directory.

2. Select the Species tab in the List Area and observe the initial quantities.
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Species | Proteins | Genes | RMNAs | asRMNAs | Reactions | Compartments | Parameters | Functions | UnitDefinitions | Bules | Events | SpeciesTypes | Compartn
clazs id name zpeciesType | compart. poszition. | included quantity.. ( initialGluantity zub..  haz0. bc B
FROTEIN |MKEEK  |MEEK uol inzide Amourt | (2800 falze falze |falze
FROTEIMN |MKEK |MKEK uol inzide Amount | (900 falze falze |falze
FROTEIM |MAPK |MAPK uol inzide Amourt | (2800 falze falze |falze
FROTEIMN |MKEEK.. |MKEK uol inzide Amount | [100 falze falze |falze
PROTEIM |MEE_P [MEE Lol ingide Amount | (100 falze falee  |falee
PROTEIM |MEEK_. [MEE Lol ingide Amount | (100 falze falee  |falee
PROTEIM |MAPK..|MAPK uol inzide Amount | [100 falze falze |falze
PROTEIM |MAPK../MAPK uol inzide Amount 4100 falze falze |falze

Select the Reactions tab in the List Area to see how the kinetic laws and parameters are
specified.
Species | Proteins | Genes | RMAs | azRMAs | Reactions | Compartments | Parameters | Functions | UnitDefinitions | Rules | Events | Species
type id name rev.. | fast | reactants products modifiers (" math N
STATE_TRANSITIO..|JO Jo falze |false  |MKKK MEKE_P MAFPK_PP W1 # MEKE S (0 + pow (MAFK_PF £ .
STATE_TRANSITIO..| A falze  |falze  |MKKEK_P MEKE W2 MEKK P S KK2 + MEKK P
STATE_TRANSITIO..|J2 J2 falze  [false  |MKK MEK_P MKKK_P k3 # MEKE P * MKEE S KKS + MERD
STATE_TRANSITIO..|J3 J3 talze  [false  |MKE_P MKK_PP MKKK_P kd # MEKE P # MKEE P/ (KKS + MEK.
STATE_TRANSITIO..|J4 J4 talze  |false  |MKK_PP MEK_P WE # MEK PP/ (KKE + MEK_PPY
STATE_TRANSITIO..|J5 J5 talze  |false  |MKK_P MEE W # MEK_P S KKG + MEE_PY
STATE_TRANSITIO..|J6 JE falze  [false  [MAPK MA&PKE_P MKK_PP k7 * MEE PP * MAPE S (KET + MAP..
STATE_TRANSITIO..|J7? J? falze  [false  |MAPK_P MAPK_PP MKK_PP kS * MKK_PP * MAPK_P /7 (KKS + M.
STATE_TRANSITIO..|J8 JB falze  [falze |MAPK_PP MAFPK_P WO % MAPK_PP / (KK9 + MAPK_PF)
STATE_TRANSITIO..|J2 J9 falze [falze  |MAPK_P MAPK W0 # MAPE_P /(K10 + MARK_F)

In the Reactions list, double-click on the third row whose id is “J2”.

Species | Proteinz | Genes | RMAs aSRNP.Sl F{eactinnsL

Species [T

fazt

tvpe id hame ren..

STATE_TRANSITION [0 | ialee  |talze

STATF TRAMSTTI R

The Reaction dialog will open.

Hoaction

o
name
reversble

fast Ot ) falze

I IReMCtants  [gtOffroducts | 1t O Mokt mrs

=2
aliag spacies - stoichi.  stoxchometryMath
a2 MEK 10
< >
Konticlaw [ dn |
Cloce

You can also open the Reaction dialog by clicking on the Reaction on Draw Area with the
right-mouse button, then select Edit Reaction... menu. If the Reaction ID is not displayed
on Draw Area, select View — Show Reaction Id in the Menu.
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B
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7. Click Edit to display KineticLaw dialog.
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8. In the math text box, you can change the formula.
9. In the Parameters tab, you can change the parameter values.

- Note: Ticking Name checkbox will show the variables in the math text box in Species name rather than Species

ID}
math K3 % MKKE * MKK £ (K3 + MKK)
Wiew mode
< copy
[ #ath
Mame |
- Nofte: Tickina Math checkbox will show the variables in the math text box in fractional representation.

math k3 * MEKK_P#* MEK
Wiew mode KE3+ MKEE

[ Mame :
10.5.2 To add a Species ID in the math text box

1. In the math text box, put the cursor into the place where you want to add the Species ID.

| ka * MEKK_P * MKE 7 KE3 + MEK) |

- Note: Verify that the Math checkbox is NOT selected, otherwise you cannot edit the math expression.

2. In the KineticLaw dialog, in the SelectedReaction pane, select a Species (e.g. MKK_P).
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MEK MEK_P

MEK [} Mtk

[’[ ____________ It
3. Observe that the Species ID has been added.

‘ k3 # MEKE_P # MEK S KES + MEKMMEK_P

10.5.3 To edit parameters

1. Click on the Parameters tab at the bottom of the KineticLaw dialog.
2. All the parameters related to the selected Reaction are listed.

My Clear All
sCOpe id name value unitz constant
localReactiont )2} k3 0025 true
local Reaction{J2} KR 16.0 true

10.5.4 To use a Predefined Function

You can use some predefined functions such as Mass Action or irreversible simple
Michaelis-Menten, by using Predefined Functions section on the dialog.

- See also: “7 Reaction and KineticLaw”
10.5.5 To run the simulation

1. After checking all the reactions and KineticLaw formulas, close the KineticLaw dialog and
the Reaction dialog.

2. You can double check all the specified Reactions, Parameters, etc in the List Area.

3. Select Simulation — ControlPanel from the Menu, and then conduct the simulation.
You can view the graph as well as the simulated values in the Graph and Table tabs
respectively.

- See also: “Running CellDesigner Simulation with ControlPanel” found in the documents folder.
10.5.6 To save or print the simulated Graph

Select File — Save Image / Print menu.

Image Config Dialog will be displayed.

Click Config, and display Chart Properties dialog.
Specify Title, Legend, Plot and Other, then click OK.
Click either Save Image or Print.

10.5. To save the simulation results

Click SaveAs button or select File - SaveAs menu.

Specify where you save the results.

Modified model as well as the simulation results (with .sim extension) are stored in the
specified folder.

S S e e

10.6 Reference: MAPK. XML

Reactions
id Math
JO V1 * MKKK / (1 + pow(MAPK_PP / Ki, n)) * (K1 + MKKK))
J1 V2 * MKKK P/ (KK2 + MKKK P)
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J2

k3 * MKKK_P * MKK / (KK3 + MKK)

J3

k4 * MKKK_P * MKK_P / (KK4 + MKK_P)

J4

V5 * MKK_PP / (KK5 + MKK_PP)

Jb

V6 * MKK P/ (KK6 + MKK_P)

J6

k7 * MKK_PP * MAPK / (KK7 + MAPK)

J7

k8 * MKK_PP * MAPK_P / (KK8 + MAPK_P)

J8

V9 * MAPK_PP/ (KK9 + MAPK_PP)

J9

V10 * MAPK P/ (KK10 + MAPK P)
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Species

Parameters

id initial Quantity
MKK 280
MKKK 90
MAPK 280
MKKK_P 10
MKK_P 10
MKK_PP 10
MAPK_P 10
MAPK_PP 10

id name value
Vi1 2.5
Ki 9
n 1
K1 10
V2 0.25
KK2 8
k3 0.025
KK3 15
VO VO 111
Ko Ko 1
k4 0.025
KK4 15
V5 0.75
KK5 15
V6 0.75
KK6 15
k7 0.025
KK7 15
k8 0.025
KKS8 15
V9 0.5
KK9 15
V10 0.5
KK10 15
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10.7 MAPK42.xml

MAPK42 .xm1 is identical to MAPK.
displayed as layered text.

xm1 except that it contains KineticLaw and MIRIAM information

uvol bgbiolisHomologTo = Reactome: REACT_525
bbiolisversionOf =Enzyme Momemclature 2.7 .11 1
=z 0005349
bohiolisYersionOf = =G2:0000183
UniProt: POSSE0
Lol * T MEEK (0T + pow{MAPK_PP {Ki, ) * (K1 + MEKK))
) bgjbiol isHomologTo
Lol * W2 MKKK_P 1 (KK2 + MKKK_P) = Reactome: REACT_B14
—— ; bghialisversionOf
babioLisversionOf =Enzyme Momemclature 2.7.11.25
=Enzyme Momemclature 3.1.3.16 =00: 0006468
=G0:0006470 =G0:0004709
=G0:0051390
Lol * k3 MKKE_P * MK (KK3 + MKK) Lol * et MKKE_P * MKK_P J (KK + MEKK_P)
|f- ) P
bobiokis'ersionof :
= UniProt:P0S116 [ MAPKK -
ual * W& * MKK_P 1 (KKE + r-np{p{__P) Ul * V5 MEK_PP 7 #KS +[MKK_PF) 1
bghiolisversionOf -bqbiol:isversionOf
=Enzyme Momemclature 3.1 318 =Enzyme Momemclature 3.1.3.16
=G0:0008470 =G0 0005470
; =(3(:0051359
bghiolisHomologTo
= Reactome: REACT_136
= Reactome: REACT_2247
bobiolisversionOf
=Enzyme Momemclature 2.7.12.2
=G0:0000187
=G0:0004708
Lol * RT * MKK_PP * MAPK [ (KKT + MAPK) uwi'ol * k8 * MKK_PP * MAP)_P § (KK + M£)PK_P)
R /F\ /P—\ ———————————— .
I
hghiolis\ersionOf !
= UniProt: P26696 L MAPK. i
_ L _ ) | Pz-_-------——_a’l_
utol * W10 * MAPK_P / (KI10 + MAPK_P) ol * 9 * MAPK_PP f (KKS + MAPK_PP)
'bqbinl:isuersionOf hghiolisversionOf
=Enzyme Momemclature 3.1.3.16 =Enzyme Momemclature 3.1 .3.16
=G0: 0006470 =G0: 0006470
=(G0: 0000188

- See also: “12 Layer — dis

playing comments over the model”
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11. Gene / RNA/ AntiSenseRNA Structure Expressions

In CellDesigner 4.x, graphical notation is extended and redefined to enhance representation
capability for transcription and translation processes. The most salient feature is the capability to
describe promoter structure, and other detailed structure for genes and RNA’s.

Protein A*

reg
- T8S2 |______J1ss1 Sege TEET TeE2
Gena A L T /é5 Gene A
it & 1

7 TF
red »
.
I, 1R
Protain A' Protein A" .
[ = > {es/
1552 J7ssi 25
GeneA B 1
b

O N .
frmar]

- See also: “Appendix 2: Sample Files for Graphical Notation”

11.1 Promoter Structure Representation

CellDesigner allows users to define the structure of promoter regions. Specific promoter regions are
represented on upper part of the box. When such structure information is defined, lines for both
sides and lower part of the box are either not shown or dimmed to highlight structures represented
on the upper line.

11.1.1 Symbols related to transcription and translation

madificationSite TSS_L TES_R
GEME A CodingRegion RegulataryRegion
4{ I I | I }_
m2 | | modification site
CodingRegion Geneal Regulatory Region

e g

11.1.2 An example of transcription related symbols

~

"

O
X / ;
i - : O B A > m
Complan(XY_TF1) )
<
£ ™,

Compler with borger >

. [ ]
ey e 3

§_ Comglexwimnoborder
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11.1.3 To specify region symbols

1. Right-click on a Species.

2. Select Edit <Gene or RNA or asRNA>...
from the menu.
Alternatively, select the Species from the
List Area and click add button.

3. In the Modification Region dialog, select a
type from the drop-down menu and
change the size and position. positien J

Click Close.
4. Click Update.

11.1.4 To change the modification of the
modification site of a Gene

E Modification Region

name
type Modification Site b
active

size

5. Right-click on a Gene.
6. Select Change Identity... from the menu.
7. Click the target empty region and change the modification status from the drop-down
menu.
class GEMNE v
hypothetical (]
name
homamultimer 1
gene =2 w
name
tvpe
regions
modification empty b
state phosphorylated
text input acetylated
methylated
[ﬂdon't care
unknown

8. Click Apply.

11.2 Alternative Splicing

Alternative splicing can be represented as transition of an RNA in the original state to multiple
RNAs with different splicing patterns.

11.3 Identification of Gene, RNA, and AntiSenseRNA.

In the model, Genes, RNAs and AntiSenseRNAs are identified by their name. If the name of the
newly created component is already used in the model, the representation will become the same as
the existing one.
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12. Layer — displaying comments over the model

You can add a layer to give comments to the components and over the model. The “base” layer is the
layer where the components are displayed. Additional layers can hold free text to those components,
or draw the circle or square. You can choose to display or to hide the layers.

12.1 Add a Layer

12.1.1 To add a layer

1. Select Edit — Add Layer in the Menu.

2. LayerNamelnputDialog is displayed.

3. Specify the Layer Name, then click Add Layer button.

4. In the Layer Area, find a new layer has been added to the list.

_— clas:

_4 Layer

12.2 Add Text and Shapes on a Layer

12.2.1 To add atextbox to a component

1. Select a component (Species, Reaction, or Compartment).
2. In the Layer Area, select the target layer.

3. In the Menu, select Component— Add Text.

Or, right-click on the component and select Add Text.

In the Input text dialog, enter any text, then press OK.

5. The text is added to the specified component.

File Edit | Component View Database Laout Simulstion Phagin Windon

~

|ETES 831 Find Species. owkr [FriiiE | TE

| —+%¢-3e-  Changs Kentity. ll s WE{

4 Mode! Sat hactive A

4 ) Con : (Reds o E »

| Rea Model Riformation.
Model Notes_ ey :
Species Notes.. sesrnesmnes, N CAK
- Protain. Geos, RNA avRNA Notes. , ft ! i
Change Color & Shape_ CAK ==
- N Check this

O
Cde13

This "
Tyr1s Th167

-~
3 Layer

N o]

® base

Theld,
Ty115 The167

fL%/ ©,
®
0
a
O

12.2.2 To add a Layer Object onto a layer

1. In the Layer Toolbar, select an icon from the different Layer Objects.
LN = = Y

2. Place your cursor on Draw Area, click-hold the mouse button, and drag the cursor to the
size and shape you like.
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12.2.3 To change the color and shape of a Layer Object

1. Right-click on a Layer Object to open the Change Color & Shape... dialog.
2. Change the parameters and click OK

12.3 Edit a Layer

12.3.1 To lock the Layer Objects on a layer

1. In the Layer Area, select a layer.

- Note: The base layer cannot be locked, deleted nor set invisible. For it contains all the components (Species,
Reactions and Compartments) and holds no Layer Objects in it.

2. In‘the right-click menu, select Lock.

A Layer ‘
o [T .
o tite
Ivisble
Delete Layer

3. Verify that all the La;er Objects on the layer cannot be selected.
12.3.2 To set the Layer Objects invisible

1. In the Layer Area, select a layer.
2. In the right-click menu, select Invisible.
3. See that the Layer Objects belonging to the layer are invisible.

12.3.3 To delete a layer

1. In the Layer Area, select a layer.
2. In the right-click menu, select Delete Layer.
3. See that the Layer Objects belonging to the layer have been deleted.
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13. SBGN PD View

CellDesigner graphical notation can be converted to SBGN Process Description notation.

You can use the SBGN PD Viewer from CellDesigner to readily obtain an SBGN process description
graphical representation for the model created with the CellDesigner.

You can also export the graphical information in the SBGN-ML (XML exchange) format. The
SBGN-ML file format can be imported to the tools which support SBGN-ML.

- Note: CellDesigner's SBGN Viewer adopts the SBGN Process Description Diagram Level 1.1.
- Note: Details for SBGN-ML format, please refer to http://sbgn.org.

13.1 Use the SBGN PD Viewer

13.1.1 To view a model with the SBGN PD Viewer

1. Open a model.
2. On the View menu, select Convert to SBGN PD view.

13.2 Difference In Graphical Notations---CellDesigner and SBGN PD Viewer

There are some differences in graphical representation between the two.
Difference in Activated State

In CellDesigner’s notation, activated proteins are surrounded by dotted line. (or open state for
Ton_channel).
In SBGN Process Description notation, activated proteins will have an oval at the bottom (States).

. . . [' W
Protein—Generic (activated) ! !
i\ ) CHotive

Protein—Ion Channel (activated) | Dn ol D
Chetive D

Difference in Various Species Shapes

In SBML PD viewer, various Species shapes are represented by rounded square.

Protein —Receptor type Rataptor

Protein —Truncated type Truncated Truncated
Protein Protein

Protein —Ion_Channel type .' Jon._Channel

RNA S o

:
:
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Antisense RNA AntiSenseRMA

Difference in Notation of Clone Marker

If a Species is duplicated, both the original and the duplicates will be marked by the clone marker
(bottom part shaded).

fon
Simple molecule
p Sinfple_Maolecie Sifple_Malecle

Resides/Domains etc -> Information box

Gene / RNA / asRNA with
Coding Region, Modification Site,

Transcription Starting Site, ] ] 1]
and Regulatory Region m dﬁ“

Difference in Notation of Transcription/Translation

Reactions of Transcription and translation are converted into the reactions with triggers.

Transcription _ - 4‘ Prossn ¢ ’
senac | O — e R wuss
‘:;f'}r
Translation ; . R 4{ RNAC
—-{1—-—= PmiEns AV

Difference in Association/Dissociation

In the SBGN PD Viewer, a process node is positioned near the fork.

Association

Dissociation

13.3 Show SBGN Compliants

CellDesigner has functionality that shows which parts in a model are SBGN compliant. When this
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option is enabled, parts that are not compliant are grayed out.

13.3.1 To toggle on and off the SBGN compliants option

1. Open the model.
2. Select Show SBGN Compliants from the View menu.

- Note: Reactions or Species in CellDesigner that are not supported in SBGN PD will be processed as shown
below:

> When the “Show SBGN Compliants” option is selected: Grayed-out in CellDesigner .
> When the “Convert to SBGN PD View” command is selected: Removed in SBGN view.

Moreover, since Reduced Notation is not supported in SBGN PD view, it will be processed as shown
below as well.

- » When the “Show SBGN Compliants” option is selected: Grayed-out in CellDesigner .
> When the “Convert to SBGN PD View” command is selected: Removed in SBGN view.

13.4 Export to SBGN-ML file format

13.4.1 To export a model to SBGN-ML format

1. Open a model.

2. On the File menu, select Export to SBGN--- menu.
3. Specify the file name, then Save.

4. The file is saved with the extension of .sbgn.
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14. Limitations and Known Issues

14.1 Limitations

Available actions of UNDO and REDO are limited to actions making change on the Draw Area.

14.2 Known Issues

® The problems are reported in printing / exporting images of the huge model due to the lack of the
memory.

® \When using CellDesigner in non-English environment on Mac OS X and Linux, letters on dialog
boxes from File menu are not correctly displayed.

® [For Mac OS X, open “System Preferences” and click “International” icon from “Personal” row, and
then click “Language” tab. In the window for choosing language, place “English” at the top. (Note:
The terms quoted by “ ” depend on your environment.) Then start CellDesigner.

® For Linux, unset LANG in the shell, then starts CellDesigner.
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Appendix 1: Symbols and Expressions

This section lists up all the symbols for building models with CellDesigner. Graphical notation and
the list of the symbols are based on the proposals by Kitano:

“Using process diagram for the graphical representation of biological networks”, Nature
Biotechnology 23(8), 961-966 (2005).

The symbol system for state-transition diagram and the residue state representation in these
proposals are mostly realized with CellDesigner.

- See Also: http://sbgn.org for SBGN (Systems Biology Graphical Notation scheme.)

Species Reactions

Protein ”rei‘m EE';:’;:G i activated |} Standard Notation (Process Description Diagram) Reduced Notation

I negave infuence (A J———
©
; caayss ot ifnce
(1) reduced moduiaton ofs ]
q  Paimytoylated|
homodimer formation !
® &
unkonwn catalysis [ A unknown negative nfluence
Prenylated . «— Ot ,
o bidirectional reaction @ unknown positive influence
5 ‘
nated A o 1
unknown nhibiton onknown reduced stimulation
vanscrpton a4

=
® |3
i

G G
add rescane <>

—
Methylated @

add product

i

o

heterodimer
Plasma embrane assocaton (o2 >
Species 2
) (=)
Complex
Reduced Notation
Complex
C Boolean Logic Gate Style Variation Layer

- Cl [ [ ) ]
Compartment Square Compartment oval @ P © 9
&—{s] 3 (J——={] (o

And or Not

Unknown

Compartment Boole Style Layer Annotation

A sample file: Components44.xml

- Note: All the graphical symbols used in CellDesingner will be found in the file “<your CellDesigner
folder>/samples/components44.xml”.

Appendix 1.1 Basic Symbols

Appendix 1.1.1 Species

There are 14 types of Species symbols.

Species not activated activated
Protein . i ) i
-Generic Frotein i Protein j
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Species

Protein
-Receptor

Protein
-Ton channel

not activated

I6n_Chann

activated

f————— =

=)
o
=
o
=
o

Appendix 1.1.2 Modifications of Protein Residues

There are 14 types of symbols for residue modification states. The residue symbols accompanied
with their label (used for residue name and position in amino acid sequence) can be attached to all

protein-type Species.

Protein 'IJI |
-Truncated Ti e f = u:.'
—ﬁ i'r _______________ ﬁ ‘\
Complex
Complex il Complex
| N
Gene Gene n/a
Anti-sense RNA A n/a
Phenotype n/a
Ton n/a
Simple Molecule Sile n/a
Unknown unknown n/a
Tag Tag
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Modification Symbol

Phosphorylated Protein

Acetylated Protein

Ubiquitinated Protein

Methylated Protein

Hydroxylated Protein

Glycosylated Protein

Myristoylated Pratein

Palmytoylated Protein

Prenylated Protein

Protonated Frotein

Sulfated Protein

Empty Frotein

Unknown Frotein

Don’t Care Protein

1] ] i | o]l

Appendix 1.1.3 State of Proteins
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Closed Protein
User defined .
Protein

Appendix 1.1.4 Modifications of Gene / RNA / AntiSenseRNA Residues

There are 5 types of symbols for residue modification states. The residue symbols accompanied with
their label (used for residue name and position in amino acid sequence) can be attached to Gene /
RNA/ AntiSenseRNA.

Modification Region Symbol

phosphorylated @
Phophaorylated
acetylated @
Acetylated
methylated @
Methylated
Unknown @
nknown
Don’t care Q
Daon't Cara

Appendix 1.1.5 Compartment

There are 4 types of Compartment symbols. For each type, the thick line indicates outside of its
boundary.

Type Symbol Note
Square
Oval
i = Northwest, Northeast
Close-up type
Southwest, Southeast
= I
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Symbol

|| || West, East

Close-up type North, South

Appendix 1.1.6 Reaction (State Transitions and others)

There are 11 symbols representing State Transitions and other types of Reactions.

Modifier

PIP kinase

ModificationLink

(e Dect—s
Baselink

Product Reactant
Reaction

Reaction Symbols
(State Transitions and others)

State Transition A —T1—m B
Known Transition Omitted A B Abbreviated syrnbol of
several Reactions

Unknown Transition

Transcription

Translation

Transport

Heterodimer Association

Dissociation
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Reaction Symbols

(State Transitions and others)

Dissociation of Proteins by

. E] truncation.
Truncation i

Add Reactant

Appendix 1.1.7 Reaction (Modifications)

There are 7 symbols representing Modifications.

Reaction
(Modifications)

Catalysis

Unknown Catalysis
Inhibition

Unknown Inhibition

Physical Stimulation

Modulation

Trigger
(e
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Appendix 1.1.8 Reaction (Logical Operations)

There are 4 symbols representing Logical Operations.

Reactions Symbols
(Logical Operations)

Not )

Unknown

nknown

Appendix 1.1.9 Reduced Notation

There are 10 symbols representing Reduced Notations..

Notation Symbol Note

Positive Influence A S
Negative Influence A — 1B

Reduced Stimulation A | B

Reduced Modulation A | B
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Notation Symbol

Reduced Trigger A HE
Unknown Positive Influence T ______ > E
Unknown Negative Influence T ______ _|E
Unknown Reduced Stimulation T _____ _I;;..HE;_
Unknown Reduced Modulation (4 |- - - - o5
Unknown Reduced Trigger T _____ H:*-?

Appendix 1.2 Expressions

Here are symbols acquiring additional semantics by shape, combination of symbols, or change in
drawings.

:
I |
i I
s i s i ] s s
i i rd r4
i I
N -,

name, and

P —

i imer= ; state of
dass(=symbol type)  2cve homodimer=2 crﬁrdul-;in rmc?‘rﬁ%aﬁnn
ax.
phosphorylated
Expression Symbol Note
Select a Protein and, in the
Component menu, select Set
Active.
Active

Select an Ion Channel and, in
Channel Open lon_Chanpel the Component menu, select Set
Active.
Species State (o (e
Open / Closed Pratein Protein
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Expression

Homodimer formed

Symbol

Complex

Cnmplex(C:ycIinE,CcIcz)J

Con |15Iex(Cchi|1E=,' de2)

Complex in a Complex

Hypothetical Species

Reversible Reactions A

Bidirectional Reactions

Homodimer Formation A

Degradation of Species A

Note

Double-click the Species to
open the identity dialog, then
set the Homodimer number.

Set Change Complex View to
normal / compact / no border.

compact 1s used to hide the
contents of the Complex.

no border is mainly used for a
Complex with Genes etc.

Double-click the Species to
open the Change identity of the
species dialog, then select
hypothetical.

Double-click the Reaction, then
set Reversible to True.

Simply draw two state
transitions and reposition

them.

Click the icon of Homodimer
Formation.

Click the icon of Degradation.
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Appendix 2: Sample Files for Graphical Notation

To explore new graphical notation scheme, there are sample files available in this version. Please
open the files in the /samples directory and try editing the model.

Appendix 2.1 Examples of the sample files contained in the CellDesigner

/samples/database44.xml /samples/M-Phase.xm]

PE—
- _“ .
| |
| L
- — - |
- =%l <
——— —— - - 1
=4 ‘ ‘ —
L — |
’ |
> |
|
A S
- v ‘
g
. o
. - » -
- o
-~ b ’
uvol bebiokisHomologTo = Reactome: REACT 525
lhakiokisVersionOf = =G0:0000185 .
o 1
Vel * YT MRKK (1 + pow(MAPK_PP [ Ki, n)) * (K1 + MIKK))
-1y z
=Reactome: REACT_B14 M
bgbiok igversionOf T
~Enzyme Nomemciature 27.11.25 — .-
=GO0006468 i |
bapiol s Versionof | N
= UniProtPOS116. [ MAPKK MAPKK .
C ) -
bgbiolisHomologTo - -
lqbiolisversionOf
=G0:0000187 -
/samples/sim2.xml
Vol * K7 * MKK_PP * MAPK / (KKT7 + MAPK) - (K [
= UniProt:P26696 HAPIC
"y R Ao G « t < 108
uVol * V10 * MAPK_P / (KK10 + MAPK_P) uvol * V8 * MAPK_PP / (K9 + MAPK_PP)
bapiotisversionOf babiolisversionOf Ae Es
A vl E
P 5 F
Mra‘E , (R M -
- -
4 " » : ’
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/samples/Macros.xml /samples/SBGNRefcCard.xml

Macrog: Add Catsysis

[SBGN Process Description Diagram and CellDesigner Notation Comparison

Entity Pool Nodes Auxiliary Units Process Nodes Connecting Arcs Logical Operators

o]

N = oro
acos: Add i Aok
A i
e
— A
A j
Macro10: Phosphoryaton = = el
- (e} B ——f
MacroL1: Add £t Reside Modiicaion wroel e
<) c
o

Container Nodes

IO e

MacroL3: Tranststion B —
Compartment - -
I8
A
- (—wy
Al

>
Reference Nodes
RS
=] |

/samples/unitofinformation.xm]l

Unit of Information
Container Physical Characteristics

Multimer Cardinality

/samples/notation/ReactionShape.xml /samples/notation/Complex44.xml

s1

f
]

.
{

i

Protein A Protein A FroenA i
:

H

i

:

:

|

i

:

H

H

,

‘
!
‘
H

Complex oot Protein 8 Proteins e | |

> G ‘

— :
s1 ComplexX |

P - P
CompeAlE ) B
.l; !.:ﬁ O F o
N a @ it i f
Protein G *tgx’;wi\?:’:o ai *%;Ia‘\:rtz:amu in|

Complex Z

- Complex Y Complex Z
©
O ®
2 e J - = ‘ =
- — mpiex -
ene A f ] Cene A
1
51 s Complex Gene A

= L E o ‘Compact No border

a [ﬁ

Appendix 2.2 Examples for Graphical Notation

These are the examples used in the paper
“The Process Diagram for Graphical Representation of Biological Networks,” Kitano, H. et al.
Nature Biotechnology, August 2005.

92



CellDesigner™ Startup Guide

Figlb_ProcessDiagram_4 Fig3abcd_AndOr_4

Fig3e_ EGFR_league_4

SuplFig2_GPCR beta2-AR_4 SuplFig3_NF-kappaB(p65+p50)_4
l, —]1 =] = = i

=@ =&
@ & &8 & |

4
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SuplFig5_StructureofComplex_4 SuplFig7_M-Phase_4

E
WEW ESE

SWogsw g sse SE

Reaction

Species

s1 L s2 s4
Process Node Process Node

CellDesigner Reaction and Process Nodes

st H O el s
23 3 ol
3 re3 s3 o
— — g
3 25 51 ol <3 5 6 7
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